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Product Overview

Simulink Design Optimization Product Description

Estimate and optimize Simulink model parameters

Simulink Design Optimization provides interactive tools, functions, and Simulink blocks
for estimating and tuning Simulink model parameters using numerical optimization. An
interactive tool lets you automatically estimate model parameters such as friction and
aerodynamic coefficients from test data to increase model accuracy. You can preprocess
test data, select model parameters to estimate, start an optimization, and validate
estimation results.

You can also automatically tune design parameters in a Simulink model to meet
objectives such as improved system performance and minimized energy consumption.
Using design optimization techniques, you can meet both time- and frequency-domain
constraints such as overshoot and phase margin. You can also jointly optimize physical
plant parameters and algorithmic or controller gains to maximize overall system
performance.

Key Features

* Model parameter estimation from test data

* Simultaneous optimization of time- and frequency-domain responses of Simulink
models (with Simulink Control Design™)

* Graphical specification of response requirements and visual monitoring of the
optimization progress

+  Optimization of parameters to meet requirements specified by Model Verification
blocks

+ Custom constraints and cost functions for response optimization
*  Scripting interface for programmatic specification of design optimization problems

*  Robust design optimization, accounting for parameter variation or uncertainty



Optimization Support for Simulink Models Using Third-Party Applications

Optimization Support for Simulink Models Using Third-Party
Applications

You can use Simulink Design Optimization software to optimize Simulink models that
invoke third-party simulation tools or contain legacy simulation code. To do so, use the

S-function block in Simulink. When using the command-line functions, use MATLAB®
MEX functions.

References
Cherian, V., Shenoy, R., Stothert, A., Shriver, J. et al., "Model-Based Design of

a SUV Anti-rollover Control System" SAE Technical Paper 2008-01-0579, 2008,
d0i:10.4271/2008-01-0579.

More About
“Introducing MEX-Files”
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Speeding Up Design Optimization Using Parallel Computing

When you have the Parallel Computing Toolbox™ software, you can use parallel
computing to speed up parameter estimation and response optimization. When you use
parallel computing, the software distributes the independent simulations on multiple

MATLAB sessions. Thus, the simulations run in parallel which reduces the optimization
time.

Using parallel computing may reduce the optimization time in the following cases:

*  The model contains a large number of parameters to optimize, and the Gradient
descent or Nonlinear least squares method is selected.

+ ThePattern search method is selected as the optimization method.

The model contains a large number of uncertain parameters and uncertain parameter
values.

* The model is complex and takes a long time to simulate.



Required and Related Products

Required and Related Products

Simulink Design Optimization software requires MATLAB, Simulink, and Optimization

Toolbox™ software.

The following table summarizes MathWorks® products that extend and complement the
Simulink Design Optimization software. For current information about these and other
MathWorks products, visit http://www.mathworks.com/products/.

Product

Description

Control System Toolbox

Enables you to design controllers for
linear time-invariant (LTT) models using
optimization methods.

Global Optimization Toolbox

Provides genetic algorithms, and direct
search methods to estimate and optimize
model parameters.

Neural Network Toolbox

Provides Simulink models of neural
networks for optimization-based control
design.

Parallel Computing Toolbox

Enables parallel computing on multicore
processors and multiprocessor networks to
speed up estimation and optimization.

Simulink Control Design

Lets you linearize Simulink models. Use
Simulink Design Optimization software
to design controllers for linearized models
using optimization methods.

System Identification Toolbox

Lets you estimate linear and nonlinear
models from measured data. Import the
estimated model into Simulink software,
and use Simulink Design Optimization
software for optimization-based control
design.
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* “Supported Data” on page 2-2
+ “Prepare Data for Parameter Estimation” on page 2-3

+ “Estimate Parameters from Measured Data” on page 2-16
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Supported Data

From signal data, you can estimate model parameters and initial conditions of single or
multiple input and output Simulink models.

Simulink Design Optimization software lets you estimate model parameters from the
following types of data:

*  Time-domain data — Data with one or more input variables u(Z) and one or more
output variables y(¢), sampled as a function of time. See “Import Data”.

*  Time-series data — Data stored in time-series objects. See “Time-Series Data”.

Simulink Design Optimization software estimates model parameters by comparing the
measured signal data with simulation data generated from the Simulink model. Using
optimization techniques, the software estimates the parameters and initial conditions
of states to minimize a user-selected cost function. The cost function typically calculates
a least-square error between the measured and simulated data. To learn more, see
“Estimate Parameters from Measured Data” on page 2-16.

More About

. “Time Series Objects”

. “Complex Data”
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Prepare Data for Parameter Estimation

In this section...
“About This Tutorial” on page 2-3

“Start a Parameter Estimation Tool Session” on page 2-4

“Create an Experiment for Parameter Estimation” on page 2-6
“Import Data” on page 2-7

“Analyze Data” on page 2-7

“Extract Data for Estimation” on page 2-9

“Replacing Outliers” on page 2-10

“Filtering Data” on page 2-12

“Saving the Session” on page 2-14

About This Tutorial

* “Objectives” on page 2-3
+ “About the Sample Data” on page 2-4

Objectives

This tutorial explains how to import, analyze, and prepare measured input and output (I/
0) data for estimating parameters of a Simulink model.

Note: Simulink Design Optimization software estimates parameters from real, time-
domain data only.

Perform the following tasks using the Parameter Estimation tool:

* Import data from the MATLAB workspace.
+ Analyze data quality using a time plot.

*  Select a subset of data for estimation.

* Replace outliers.

+ Filter high-frequency noise.

2-3
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2-4

About the Sample Data

Load spe_engine_throttlel.mat, which contains I/O data measured from an engine
throttle system. The MAT-file includes the following variables:

* inputl — Input data samples

+ positionl — Output data samples

+ timel — Time vector

Note: The number of input and output data samples must be equal to the length of the
corresponding time vector.

The engine throttle system controls the flow of air and fuel mixture to the engine
cylinders. The throttle body contains a butterfly valve which opens when a driver presses
the accelerator pedal. Opening this valve increases the amount of fuel mixture entering
the cylinders, which increases the engine speed. A DC motor controls the opening angle
of the butterfly valve in the throttle system. The input to the throttle system is the motor
current (in amperes), and the output is the angular position of the butterfly valve (in
degrees).

spe_engine_throttlel contains the Simulink model of the engine throttle system.

Start a Parameter Estimation Tool Session

To perform parameter estimation, you must first start a Parameter Estimation tool
session.

1  Open the engine throttle system model by typing the following at the MATLAB
prompt:

spe_engine_throttlel

This command opens the Simulink model, and loads the data into the MATLAB
workspace.
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Engine Throttle Model

Input

Motor

Positicn

» -

Position
In the Simulink model window, select Analysis > Parameter Estimation.

This action opens a new session, Parameter Estimation - spe_engine_throttlel,
in the Parameter Estimation tool.



2 Parameter Estimation

4\ Parameter Estimation - spe_engine_throttlel EI@
[ PARAMETER ESTIMATION VALIDATION
|| Open Session ¥ % E E E Eli Cost Function:  Sum Sguared Error « |>
5 savesession v Select New Select  AddPhot PlotModel 5 yrore Options... Estimate
i i - Ri -
FILE FARAMETERS EXPERIMENTS PLOTS OFTIONS ESTIMATE

Data Browser @

w Parameters

w Experiments

w Results

w Preview

Note: The Simulink model must remain open to perform parameter estimation tasks.

Create an Experiment for Parameter Estimation

In the Parameter Estimation tool on the Parameter Estimation tab, click the
New Experiment button. This will create an experiment with the name Exp in the
Experiments list on the left pane. You can rename it by right-clicking and selecting
Rename from the list. For example, call it NewDatal.
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Import Data

This portion of the tutorial explains how to import measured I/O data into the
experiment in the Parameter Estimation tool. Importing data assigns the data to the
corresponding model input and output signals.

The model input and output signals are designated with the Inport Input and Outport
Position blocks, respectively, as shown in the figure. To learn more about the blocks,
see the “Inport” and “Outport” block reference pages in the Simulink documentation.

To import data into the experiment, right-click and select Edit... to launch the
experiment editor. Import the output data by typing [timel, positionl] in the dialog
box in the Outputs panel. Import the input data by typing [timel, inputl] in the
dialog box in the Inputs panel.

Edit Experiment: Newlatal
Outputs i
Define measured output signals for this experiment.

spe_enging throttlel Throttle:l (Position]
<1x1 Signal, 701 points> v B & X

@ Select Measured Output Signals

Inputs
Optionally define input signals for this experiment.
spe engine throttlel Anput:l {Input]

| time1, inputt] ~| B & x

m

@ Select Inputs

Analyze Data

This portion of the tutorial explains how to analyze the output data quality by viewing
the data characteristics on a time plot. Based on the analysis, you can decide whether
to preprocess the data before estimating parameters. For example, if the data contains
noise, you might want to filter the noise from the system dynamics before estimating
parameters.
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To create an experiment plot, click Add Plot on the Parameter Estimation tab and
select the experiment name, for example, NewDatal under Experiment Plots.

| Experiment plot: MewDatal |

(=)

NewData1

_ Position
150 T T T T T

Measured
1o /\J,V_L__L_MJ.L] i — i

Input

Amplitude

0.8 |- -

0.4 f .

0.2 -

0 1 | 1 | 1 |
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7

Time (seconds)

The time plot shows the output data in response to a step input, as described in “About
the Sample Data” on page 2-4. The plot shows a rapid decrease in the response after

t = 0.5 s because the system is shut down. To focus parameter estimation on the time
period when the system is active, select the data samples betweent =0 s and t=0.5s, as
in “Extract Data for Estimation” on page 2-9 .

The spikes in the data indicate outliers, defined as data values that deviate from the
mean by more than three standard deviations. They might be caused by measurement
errors or sensor problems. The response also contains noise. Before estimating model
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parameters from this data, remove the outliers and filter the noise, as described in
“Replacing Outliers” on page 2-10and “Filtering Data” on page 2-12.

You can also plot the experiment data by right-clicking the experiment, for example
NewDatal, and selecting Plot measured experiment data from the list.

Extract Data for Estimation

This portion of the tutorial explains how to select a subset of I/O data for estimation. As
described in “Analyze Data” on page 2-7, the system is shut down at t = 0.5 s. To

focus the estimation on the time period before t = 0.5 s, exclude the data samples beyond
t = 0.5 s. This operation selects the data between t =0 s and t = 0.5 s for estimation.

First, import the data into the experiment, as described in “Import Data” on page
2-7.

To select the portion of data betweent=0s and t=0.5 s:
1  Plot the measured data as described in “Analyze Data” on page 2-7, to have
access to the Experiment Plot tab.
2 On the Experiment Plot tab,click Extract Data to launch the Extract Data tab.
3 Enter 0 in the Start Time: field and 0.5 in the End Time: field.
4 Click Save As to save data in a new experiment, for example, NewDatal 1.
The Parameter Estimation tool extracts the corresponding input data. To plot the new
data, click on Add Plot on the Parameter Estimation tab. Select the experiment

name, for example, NewDatal 1 in the Experiment Plots list to display the experiment
plot of the data fromt=0stot=0.5s.

2-9
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| Experiment plot: NewDatal | Experiment plot: NewDatal_1 |
MNewData1_1
Position
150 T T T T T T T
Measured
100 N 1 . I ' _
50 | //r .
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2 0 ! ! ! ! ! ! ! ! !
=
=
E 1 T T T T IHPUI T T T T
<
0.8 | —
0.6 | —
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Replacing Outliers

+ “Why Replace Outliers” on page 2-10
* “How to Replace Outliers” on page 2-11

Why Replace Outliers

Outliers are data values that deviate from the mean by more than three standard
deviations. When estimating parameters from data containing outliers, the results might
not be accurate. Hence, you might choose to replace the outliers in the data before you
estimate the parameters.

2-10
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How to Replace Outliers

In the experiment plot of the data extracted as in “Extract Data for Estimation” on page
2-9, you can visually detect the data points that seem to be outliers. To replace these
points:

1

In the Experiment Plot tab, click Replace data to launch the Replace data
tab. The experiment plot shows the preview data, which is in light brown. On the
preview, select the data point that you want to replace.

On the Replace Data tab, click Replace data and select the constant value. For
example, replace the output signal data that correspond to time points 0.00899 and
0.0189 with 15, that corresponds to the time point 0.149 with 86, and the rest of the
outlier data points with 90.

Click the arrow in the Update section and select Save As: Create a new
experiment from the modified data. Parameter Estimation tool saves the
modified data in the new experiment, for example, NewDatal 1 1.

Click Add Plot on the Parameter Estimation tab and select the new experiment,
for example, NewDatal 1 1. This creates an experiment plot of the modified data.
The spikes, that indicated outliers, no longer appear on the time plot.

2-11
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2-12

| Experiment plot: NewDatal -| Experiment plot: MewDatal 1 | Experiment plot: NewDatal 1 1 |
NewData1_1_1
Position

e e i e b A e
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Filtering Data

This portion of the tutorial explains how to filter the noise and remove any periodic
trends from the output data. First remove the outliers from the output data, as described
in “Replacing Outliers” on page 2-10.

Click the experiment plot for the new experiment, for example, NewDatal 1 1. On the
Experiment Plot tab, click Low-Pass Filter.

1 On the Low-Pass Filter tab select Filter all signals.
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Enter 0.4 in the Normalized cutoff frequency field.
Click Options. Enter 1 in the Filter order field and click OK.

b
Filter order: |1
[ Zero-phase shift fitter

0K Cancel Help

Click the arrow in the Update section and select Save As: Create a new
experiment from the modified data. Parameter Estimation tool saves the
modified data in the new experiment, for example, NewDatal 1 1 1.

Click Add Plot on the Parameter Estimation tab and select the new experiment,
NewDatal_1_1 1. This creates an experiment plot of the modified data. The noise is
filtered and the output data appears smooth.

2-13
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+v'| | Experiment plot: NewDatal 1 | Experiment plot: NewDatal 1 1 | Experiment plot: NewDatal 1.1 1 |

NewData1_1_1_1

Position
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Saving the Session

After you prepare the data, delete the data in the older experiments, for example, New
Datal, New Datal 1,New Datal 1 1. You can rename the last experiment, for
example, NewDatal 1 1 1 as NewDatal, and save the session.

To delete the experiments, right-click the experiment name in the Experiments pane,
and select Delete from the list.

To save the session, click Save Session on the Parameter Estimation tab to
select where to save the session. Specify a name for the session, for example,

2-14
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spe_engine_throttlel sdosession.mat in the File name or Session field, and
then click Save or OK. This saves your parameter estimation session as a MAT-file.

To learn how to estimate parameters from this data, see “Estimate Parameters from
Measured Data” on page 2-16.

2-15
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Estimate Parameters from Measured Data

2-16

In this section...

“About This Tutorial” on page 2-16
“Estimate Model Parameters Using Default Estimation Settings” on page 2-19

“Improve Estimation Results Using Parameter Bounds” on page 2-29

“Validate Estimated Model Parameters” on page 2-32

About This Tutorial

* “Objectives” on page 2-16
+ “About the Model” on page 2-16

Objectives

This tutorial shows how to estimate parameters of a single-input single-output (SISO)
Simulink model from measured input and output (I/0) data.

Note: Simulink Design Optimization software estimates parameters from real, time-
domain data only.

You can perform the following tasks using the Parameter Estimation tool:

* Load a saved session containing data
+  Estimate model parameters using default settings

+ Validate the model, and refine the estimation results
About the Model

This tutorial uses the spe_engine_throttlel Simulink model, which represents an
engine throttle system.
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Engine Throttle Model

Input

Motor

The throttle system controls the flow of air and fuel mixture to the engine cylinders. The
throttle body contains a butterfly valve that opens when a driver presses the accelerator
pedal. Opening this valve increases the amount of fuel mixture entering the cylinders,
which increases the engine speed. A DC motor controls the opening angle of the butterfly
valve in the throttle system. The models for these components are described in “Motor
Subsystem” on page 2-17 and “Throttle Subsystem” on page 2-18.

The input to the throttle system is the motor current (in amperes), and the output is the
angular position of the butterfly valve (in degrees).

Motor Subsystem

The Motor subsystem contains the DC motor model. To open the model, double-click the
corresponding block.

Components of the Motor subsystem |Description

Variables U is the input current to the motor.

T is the torque applied by the motor.

Parameters K; is the torque gain of the motor, represented by
Kt in the model.

2-17
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Components of the Motor subsystem |Description

t4 is the input time delay of the motor, represented
by input_delay in the model.

Equation The torque applied by the motor is described in the
following equation:

T(t)= KU(t—t,)

where ¢ 1s time.

Input U

Output T

Throttle Subsystem

The Throttle subsystem contains the butterfly valve model. To open the model, right-
click the corresponding block, and select Mask > Look Under Mask.

Velocity Fosition

| @—» 1/a —r@

Inertia

Relaxed
Position

Damping

<k

rad-to-deg

Spring

F x

Hard Stops

The Hard Stops block models the valve angular position limit of 15° to 90°.

The following table describes the variables, parameters, states, differential equations,

inputs, and outputs of the .

Components of the Throttle subsystem

Description

Variables

2-18

T is the torque applied by the DC motor.

6 is the angular position of the valve,
represented by X in the model.
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Components of the Throttle subsystem

Description

Tharastop 18 the torque applied by the hard stop.

Parameters

J is the valve inertia.
c is the valve viscous friction.

K is the valve spring constant.

States

0 is the angular position.

6 is the angular velocity.

Equations

The mathematical system for the butterfly
valve is described in the following equation:

JO+c0+ k0 =T + Thyrdsiop
where 15° <0 <90°, with initial conditions
0, =15°, and 6, =0.

The torque applied by the Hard Stops block is
described in the following equation:

0, 15° <0 <90°
Thardstop = | K(90° ~6),0 >90°
K15 -6),0< 15°

where K is the gain of the Hard Stops block.

Input

T

Output

0

Estimate Model Parameters Using Default Estimation Settings

+ “Overview of the Estimation Process” on page 2-20

+ “Specify Estimation Data and Parameters” on page 2-20

2-19
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Overview of the Estimation Process

Simulink Design Optimization software uses optimization techniques to estimate model
parameters. In each optimization iteration, it simulates the model with the current
parameter values. It computes and minimizes the error between the simulated and
measured output. The estimation is complete when the optimization method finds a local
minimum.

To start the estimation process, first open the engine throttle system Simulink model by
typing the following at the MATLAB prompt:

spe_engine_throttlel
In the Simulink Editor, select Analysis > Parameter Estimation.

This action opens a new session with the name Parameter Estimation -
spe_engine_throttlel in the Parameter Estimation tool.

Note: The Simulink model must remain open to perform parameter estimation tasks.

Specify Estimation Data and Parameters

1 Load or import the estimation data.
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4 Pararneter Estimation - spe_engine_throttlel EI@
[ PARAMETER ESTIMATION WALIDATION L e
17| Open Session w @ @ E E E‘E Cost Function:  Sum Squared Errar |>
E Save Session w Select Ne.w Sel.ec:l Add Plot  Plot Moclel @ More Options... Estimate
Parameters  Expetimert  Experiments - Response -
FILE FARAWMETER S EXPERIMENTS PLOTE OFTIOMNS ESTIMATE
Data Browser O]

w Parameters

w Experiments

MewDatal

w Results

w Previewn

a If you prepared data and saved your session as described in “Prepare Data for
Parameter Estimation” on page 2-3, load the preconfigured session. On the
Parameter Estimation tab, click the Open Session drop down list.

| 7| Open Seszion * LLJ

Open from file
Open from model workspace

Open from MATLAE workspace
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Select the correct option to browse to the location of your saved session, for
example, Open from file. Then select the MAT-file.

b If you do not have a previously saved session, create a new experiment. on the

Parameter Estimation tab, click New Experiment . In the Experiments list
on the left pane. You can rename it by right-clicking and selecting Rename from
the list. For example, call it NewDatal.

To import data into the experiment, right-click and select Edit... to launch the
experiment editor. Import the output data by typing in the dialog box in the
Outputs panel, for example [timel,positionl]. Import the input data by
typing in the dialog box in the Inputs panel, for example [timel, inputl].

Edit Experiment: MewDatal
Outputs il
Define measured output signals for this experiment.

spe enging throttlel Throttle:l [Position]

«1x1 Signal, 701 points= | & & x

@ Select Measured Output Signals

Inputs
Optionally define input signals for this experiment.
spe enging throttlel /Inputil Input]

| time1, inputL]] ~| B & X

m

@ Select Inputs

Specify parameters for estimation. On the Parameter Estimation tab, click the
Select Parameters button to open the Edit:Estimated Parameters dialog box. In
the Parameters Tuned for all Experiments panel, click the Select parameters
button to launch the Select Model Variables dialog box.

Select the parameters J, ¢, input_delay, and Kk, and click OK.
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Filter by wariable name L2
- Variable Current value Used By
J 0.05 spe engine throttlel /Throttle
Kt 174,53 spe engine throttlel /Moter/Torgue Gain
angle_init 15 spe engine throttlel /Throttle
angle_open 90 spe engine throttlel /Throttle
c 40 spe engine throttlel /Throttle
inputl 10;0,0:0:0,0,0:0:0,0:...
input_delay 0.02 spe engine throttlel /Motor/Input Delay
F
timel [0;0.016638935108...

} Specify expression indexing if necessary (e.g., a(3) or s.x)

o ok §Zcancel () Help

The Edit:Estimated Parameters window now looks as follows.

Parameters Tuned for all Experiments
1

» |_u.ns ~| B ¢ [ estimate
c

» |4o v| @, % [ Estimate
input delay

b 002 - B X% G eEstmate
k

b1 ~| B % @ eEstmate

EE Select parameters

Parameters and Initial States Tuned per Experiment
There are no experiments selected for estimation.

{7 select Experiments

B3| Update Model &7 OK  (2) Help
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The tool selects the parameters you add for estimation by default. When estimating a
large number of parameters, you can first select a subset of parameters to estimate.

Specify an experiment for estimation. On the Parameter Estimation tab, click
Select Experiments, and select the box under the Estimation column. Click OK.

Select experiments to include for estimation or validation

Estimation  Validation  Experiment

oKk (3) Help

To add progress plots, click Add Plot on the Parameter Estimation tab. Here you
can choose the Parameter Trajectory and Estimation Cost iteration plots. You
can also choose an experiment plot of measured and simulated data for NewDatal.

Estimate the parameters using the default settings. On the Parameter Estimation
tab, click Estimate to open the Parameter Trajectory plot and Estimation
Progress Report window and estimate the parameters. The Parameter
Trajectory plot shows the change in the parameter values at each iteration.
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| Iteration plot 1 | Tteration plot 2 | Experiment plot: NewDatal

404

30

20 -

Value

EstimatedParams

—t—J
—d&—c
—o— input_delay
—a—k

lteration

20

The Estimation Progress Report shows the iteration number, number of times
the objective function is evaluated, and the value of the cost function at the end of
each iteration. After the estimation converges, the Estimation Progress Report

looks like this figure.
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4| Estimation Progress Report EI@
Iteration | F-count NewDatal
(Minimize)
o 9 J2.4445
1 18 32.4445
2 27 87733
3 36 0.8228
4 45 0.225%
5 54 0.1505
3 83 0.1272
T T2 0.0992
8 81 0.0858
9 80 0.0778
10 99 0.0702
11 108 0.0842
12 "7 0.0591
13 126 0.0552
14 135 0.0534
15 144 0.0520
16 153 0.0508
ir 162 0.0487
12 171 0.0425
19 180 0.047%
‘Optimization started 186-Jun-2014 18:18:52 -
Estimation converged, 18-Jun-2014 16:20:44 = ‘
‘spe_engine_throttle1 updated with estimated parameter values
Estimated parameter values written to ‘EstimatedParams’
Estimsated experiment values written to "NewDsata1’
Estimaticn solver output: sl
[5ave heration...] [Dispay Options...| [ Estimate |

The estimated parameters are saved in the Parameter Estimation tool, in the
Results section of the Data Browser pane, as EstimatedParams. Right-click
EstimatedParams, and select Open... to view the results.
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Estimation result(z):
J=022708
c=11.346
input_delay = 0.0094373
k=-26.119

Parameters estirnated using experiments:
MewDatal, cost = 0.047861

Solver output:
Cost: 0.047861
ExitFlag: 3
FCount: 181
Date: 16-Jun-2014 16:20
Solver termination message:

Lecal minimum possible,

lsqronlin stepped because the final change in the sum of squares relative to
its initial value is less than the selected value of the function tolerance.

Stopping criteria details:

Optimization stopped because the relative sum of sguares (r) is changing
by less than options. TolFun = 1.000000e-03.

Optimization Metric Options
relative changer= 6.65e-04 TolFun = 1e-03 (selected)

EUseasini‘tialguess E‘Up{latemdel Q?OK

Examine the estimated cost function graph. Cost function is the error between the
simulated and measured output. During estimation, the default optimization method
Nonlinear least squares, “Isqnonlin”, minimizes the cost function by changing
the parameter values. The following figure displays the change in the expected cost

during iterations.
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Iteration plot 1 Iteration plot 2 Experiment plot: MewDatal

ExpCost
35

—+— MNewData1l

30
25

20

Value

15

10

6 8 10 12 14 16 18 20
lteration

7 Examine the simulated response plot to see how well the simulated output matches
the measured output. The experiment plot shows that the output simulated using
the estimated parameters is close to the measured outputs.
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Iteration plot 1 | Tteration plot 2 | Experiment plot: NewDatal |
NewData1
Paosition
Measured
Simulated
2 0 I I I I I I I I I
=
= Input
E 1 T T T T r|J T T T T
<
0.8 - -
0.6 - -
0.4r -
0.2 -
0 I I I I I I I I I
0 0.05 0.1 0.15 0.2 0.25 0.3 0.35 0.4 0.45 0.5

Time (seconds)

Improve Estimation Results Using Parameter Bounds

You can improve the accuracy of estimation by specifying bounds on parameter values.
This technique restricts the region in which the optimization method searches for a local
minima.

The engine throttle system has these characteristics:

+ All parameter values are positive.

+ Maximum time delay of the system, represented by input_delay, is 0.1 s.
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Therefore, specify 0 as the minimum value for all parameters, and 0.1 as the maximum
value of input_delay. In the Parameter Estimation tool, click the Select Parameters
button to specify bounds on the parameter values. For each parameter, click the right
arrow toggle to display the minimum, maximum, and scale fields. Specify the minimum
value for each parameter by replacing - InF with O in the Minimum field. Specify the
maximum value for input_delay by replacing +Inf with 0.1 in the corresponding
Maximum field.

input delay
w |0.02 | Oz ¥ [ Estimate
Minimum: |0 | Oz
Maximum: [ 0.1 | Oz
Scale: |0.03125 | Oz

After estimating the parameters, analyze the results using the experiment plot and the
plot for expected cost.
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" Iteration plet 1 ".l Iteration plot 2 "|. Experiment plot: MewDatal = |

NewData1

Position
1DD T T T T T T T T T

80

60

Measured
Simulated =

40

20

Amplitude

0.8+ -

0.6 - -

0 I I I I I I I I I
0 0.05 0.1 0.156 0.2 025 0.3 0.35 0.4 0.45 0.5

Time (seconds)

The data simulated using the estimated parameter values agree better with the
measured data than when the parameter limits were not specified.
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Iteration plot 1 Iteration plet 2 Experiment plot: MewDatal

ExpCost
0.25
—+— MewDatal

0.2

0.15
[45]
=
(]
=

0.1

0.05

D 1 1 1 1 1 1 1 1 1 1
0 1 2 3 4 oy 6 7 8 9 10
lteration

Validate Estimated Model Parameters

After estimating model parameters, validate the model using another data set
(validation data). A good match between the simulated response and the validation data
indicates that you have not overfitted the model.

To validate the estimated parameters using a validation data set:

1 Create a new experiment to use for validation. Name it Val idationData. Import
the validation I/O data, input2 and position2, and the time vector, time2 in
the Val idationData experiment. To do this, in the Parameter Estimation tool, in
the Experiments pane, right-click Val idationData and select Edit... to open the
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experiment editor. Then, type [time2,position2] in the output dialog box and
[time2, input2] in the input dialog box. For more information, see “Import Data”.

Outputs
Specify measured output signals for this experiment.
wThrottled [Position)

| time2, position2] | B & X
@ Select Meazured Output Signals

Select the experiment for validation. On the Parameter Estimation tab, click
Select Experiments. By default, the Val idationData experiment is selected
for estimation. Deselect the check box that corresponds to Val idationData for
estimation and select the check box for validation.

Select experiments to include for estimation or validation

Estimation  Validation  Experiment
[l MNewDatal 5
ValidationData EI,}I
w ok (3)Help

Select results to use. On the Validation tab, click Select Results to Validate.

PARAMETER ESTIMATICRN SALIDATICN EXPERIMEMT PLOT
& >
X Plot Measured & Zimulated Data
ey Select Select Results M Plot Residuals Yalidate
Experiment Experiments to “alidate -
EXPERIMENTS RESULTS | PLOT OPTIONS | WL [ DATE

Deselect Use current parameter values and select EstimatedParams, and
click OK. 2-33
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Select estimation results to validate

Results

[ D

EstimatedParams

Selected results are wsed to simulate the model and compare with measwred expriment data

w ok (3)Help

4  Select the plots for measured and simulated data, and residuals on the Validation
tab. You can assess how much the data simulated using the estimated parameters
agrees with the measured data using these plots.

[ Plot Measured & Simulated Data

4 Plot Residuals
|

On the Validation tab, click Validate to start validation.
5 Examine the plots.

a Examine the experiment plot to see how well the simulated output matches the
output data.
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Experiment plot: ValidationData | Residual plot: ValidationData |

ValidationData
Position
T

100 T T T T

Measured

8oL B g e, Simulated with EstimatedParams | |

60 - s .
a0l P e ]

20— B

[=1

Amplitude

0.8 -

0.6 -

0 1 | L L L L L Il
0 0.05 0.1 0.15 0.2 0.25 0.3 0.35 0.4 0.45 0.5

Time (seconds)

The simulated response as shown in light brown on the top experiment plot
1s overlaid on the measured out put data, and closely matches the measured
validation data.

Examine the residuals plot to compare the difference between the simulated
response and measured data.

2-35



2 Parameter Estimation

Experiment plot: ValidationData 0| Residual plot ValidationData 7 |
Residuals for ValidationData

Paosition
25 T T T T T |

Residuals with EstimatedParams

Amplitude

25 I I 1 1 I I I I I
0 0.05 0.1 0.15 0.2 0.25 0.3 0.35 0.4 0.45 0.5

Time (seconds)

The difference between the simulated and measured data varies between 2 and
-2.5. The residuals lie within 6% of the maximum output variation and do not
display any systematic patterns. This indicates a good fit between the simulated
output and measured data.

6 Save the session. On the Parameter Estimation tab, click Save Session.

ﬁs.avesﬁssiun - - sele

Save to file
Save to model workspace

Save to MATLAE workspace
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From the drop-down list select where to save the session. Specify the file name, and
click Save or OK to save your parameter estimation session as a MAT-file.
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Response Optimization

“Supported Design Requirements” on page 3-2

“Design Optimization to Meet Step Response Requirements (GUI)” on page 3-4
“Design Optimization to Meet Step Response Requirements (Code)” on page 3-18
“Design Optimization to Track Reference Signal (GUI)” on page 3-25

“Design Optimization Using Frequency-Domain Check Blocks (GUI)” on page 3-40

“Time-Domain Model Verification” on page 3-52



3 Response Optimization

Supported Design Requirements

You can optimize response of Simulink models to meet time- and frequency-domain
design requirements.

Simulink Design Optimization software optimizes model response by formulating the
requirements into a constrained optimization problem. It then solves the problem using
optimization methods.

+ For time-domain requirements, the software simulates the model during optimization,
compares the current response with the requirement and uses gradient methods to
modify design variables (model parameters) to meet the objectives.

You can specify time-domain requirements either in blocks from the Signal
Constraints library or without adding blocks to the model. You can also include
requirements specified in Check Static Range, Check Static Lower Bound and Check
Static Upper Bound blocks from the Simulink Model Verification library.

* For frequency-domain requirements, the software linearizes the portion of the model
between specified linearization inputs and outputs, compares the linear system with
the requirement and uses gradient methods to modify the design variables to meet
the objectives.

If you have Simulink Control Design software, you can optimize the model to meet
frequency-domain requirements, such as Bode magnitude and gain and phase margin
bounds. You can specify the frequency-domain requirements without adding blocks to
the model or by using the “Model Verification” blocks of the Simulink Control Design
software library.

Related Examples

“Design Optimization to Meet Step Response Requirements (GUI)” on page 3-4
“Design Optimization to Meet Step Response Requirements (Code)” on page 3-18
“Design Optimization to Track Reference Signal (GUI)” on page 3-25

“Design Optimization to Meet Frequency-Domain Requirements (GUI)”

“Design Optimization Using Frequency-Domain Check Blocks (GUI)” on page 3-40



More About

“Design Optimization to Meet Time- and Frequency-Domain Requirements (GUI)”

More About

“How the Optimization Algorithm Formulates Minimization Problems”
“Specify Time-Domain Design Requirements”

“Specify Frequency-Domain Design Requirements”
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Design Optimization to Meet Step Response Requirements (GUI)

3-4

In this section...

“Model Structure” on page 3-4

“Design Requirements” on page 3-5

“Specify Step Response Requirements” on page 3-5
“Specify Design Variables” on page 3-8

“Optimize Model Response” on page 3-12

“Save the Session” on page 3-15

This example shows how to optimize controller parameters to meet step response design
requirements using the Design Optimization tool. You specify the design requirements in
a Check Step Response Characteristics block.

Model Structure

The model sldo_model1 includes the following blocks:

|—’ FID | int Out1

Controller Flant

+ Controller block, which is a PID controller. This block controls the output of the
Plant subsystem.

+ Unit Step block applies a step input and produces the model output that should
meet step response requirements.

You can also use other types of inputs, such as ramp, to optimize the response to meet
step response requirements generated by such inputs.

+  Plant subsystem is a second-order system with delay. It contains “Transfer
Function” and “Transport Delay” blocks.
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: winz2 > % —.'(Ij

I sZ+ 2w zetas+wlh2 outl

Transport Delay

Transfer Fon

Design Requirements

The plant output must meet the following step response requirements:

* Rise time less than 2.5 seconds
+  Settling time less than 30 seconds
*  Overshoot less than 5%

Specify Step Response Requirements

1 Open Simulink model.

sys = "sldo_modell*;
open_system(sys);

¥ wlica r
Q i—“. FID | In out

Controller Plant

To learn more about the model, see “Model Structure” on page 3-4.

2 Add a Check Step Response Characteristics block to the model.

a Inthe Simulink model window, select View > Library Browser.

b Inthe Libraries pane, expand the Simulink Design Optimization node and
select Signal Constraints.
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Simulink Library Browser
Eile Edit View Help

EE »

Libraries

Enter search term

- Membership Functions
Image Acguigition Toolbox
Model Predictive Control Toolbox
Neural Network Toolbox
Robust Control Toolbox
Simscapse

Simulink 30 Animation
Simulink Coder

Simulink Control Design
Linear Analysis Plots

Model Verification

Simulink Design Optimization
Adaptive Lookup Tables
Model Verification

RMS Blocks

=)

Simulink Extras

Simulink Verification and Validation
Stateflow

System ldentification Toolbox

[]-- xPC Target

Signal Constraints

m

[E=15 EoH ==

Library; Simulink Design Optimization/Signal Constraints

Search Results: (nong) 14

4

Chedt Against
Reference

Chedk Customn
Bounds
Chedk Step Res-
ponse Charac...

Showing: Simulink Design Optimization/Signal Coenstraints

¢ Drag and drop the Check Step Response Characteristics block into the model

window.

d Connect the block to the output.

Unit Step

FID

P I Outi

Controller Flant

Chedk Step Response C haracteristics

You must connect the block to the signal on which you want to specify design

requirements.
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3 Double-click the Check Step Response Characteristics block to open the Sink Block
Parameters: Check Step Response Characteristics dialog box.

Sink Block Parameters: Check Step Response Characteristics @
Check Step Response Characteristics

Assert that the input signal satisfies bounds specified by step response characteristics.

Bounds | Assertion

Include step response bound in assertion

Step time (seconds): 0

Initial value: 0 Final value: 1
Rise time (seconds): 5 % Rise: 80
Settling time (seconds): 7 % Settling: 1
% Owvershoot: 10 % Undershoot: 1

Enable zero-crossing detection

Show Plot | [C] Show plot on block open lResponse Optimization...

‘J, OK H Cancel ” Help Apply

4  Specify step response requirements:

+ In Rise time (seconds), enter 2.5
+ In Settling time (seconds), enter 30

* In % Overshoot, enter 5
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Sink Block Parameters: Check Step Response Characteristics @
Check Step Response Characteristics

Assert that the input signal satisfies bounds specified by step response characteristics.

Bounds | Assertion

Include step response bound in assertion

Step time (seconds): 0

Initial value: 0 Final value: 1
Rise time (seconds): 2.5 % Rise: 80
Settling time (seconds): 30 % Settling: 1
% Owvershoot: 5 % Undershoot: 1

Enable zero-crossing detection

Show Plot | [C] Show plot on block open lResponse Optimization...

J OK H Cancel ” Help Apply

Click OK.

Instead of specifying time-domain requirements in the Check blocks, you can specify
them in the Design Optimization tool without adding blocks. For an example, see
“Specify Reference Signal” on page 3-26.

Specify Design Variables

Before you begin this task, specify the design requirements as described in “Specify Step
Response Requirements” on page 3-5.

When you optimize the model response, the software modifies the design variable
(parameter) values to meet the design requirements.

1 In the Simulink model window, select Analysis > Response Optimization.

Alternatively, click Response Optimization in the Block Parameters dialog box.
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A Design Optimization tool for the model opens.

4\ Design Optimization® - sldo_modell - Time plot1 EI@
DESIGN OPTIMIZATION RESPONSE OPTIMIZATION FIGURE VIEW =
Design Variables Set: None » [ New ¥ @ . n '@‘ |> 23
' Options
_ . Evaluate Mo data selected ~  Add Plot  Plot Current @ Optimize  Close
Uncertain Variables Set: Mone + @ Select  Requirements - Response - Tab
VARIABLES REQUIREMENTS PLOTS OPTIMIZATION CLOSE
Data Browser ® Timeplotl =
Search warkspace variables P~ There is no dats for sldo_model1/Check Step Response Characteristics, use "Plot Cument * or run the to updste the
w MATLAB Workspace sldo_model fCheck Step Responze
Characteristics
MName Value = ]
sys ‘sldo_mod...

w Model Workspace (sldo_modell)

MName Value

1 kd 0 -

H K 0 =

HH kp 1 E

[ ..n n cnnn o =
&

w Design Optimization Workspace

MName Value

w Variable Preview

21 e O U Ut IS U T i
a 5 10 13 20 23 30 33 40 43

Time (seconds)

The amplitude versus time plot graphically shows the step response requirements
specified in the Check Step Response Characteristics block.

2 Select New in the Design Variables Set drop-down list.
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DESIGN OPTIMIZATION RESPOMSE OFTIMIZATION

i::] Mone / @ Select E FlotCurrent Response

Create Mew Set of Design Yariables

Design Wariables Set:

Uncertain Wariahles Set: Add Plot =

MNew...
I{IF Uze to specify wariables used
WARIABL by the Sirmulink model bo optimize

PLOTS

A window opens where you specify design variables.

Create Design Variables set:

] I Variable IVaIueI Mi”"'l Max.‘.l Scale E] Variable Current value Used By
Kd D
* Ki 0
' Kp 13
wi 0.5
et 05
Update model variable values pets

» Variable Detail » Specify expression (e.q., s.x or a(3))

Click Kd, Ki and Kp to select them.

Click E to add the selected parameters to a design variables set.

Create Design Wariables set: |Design‘u‘ar5 |

“ariahle Yalue Minimum | Maximum Scale
kd 0 -Inf Inf 1
Ki I -Inf Inf 1
kKp 1 -Inf Inf 1

The software displays the following parameter settings:

* Variable — Parameter name
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* Value — Current parameter value
* Minimum and Maximum — Parameter bounds

* Scale — Scaling factor for the parameter

The check-box indicates that the parameter is included in the design variable set.
The default design variable set name is DesignVvars.

To limit the parameters to positive values, enter the minimum value of each
parameter as O in the corresponding Minimum field and press Enter.

Create Design Variables set: | DesignVars

Variable Value | Minimum | Maximum Scale
Kd ] ] Inf 1
Ki 0 ] Inf 1
Kp 1 ] Inf 1

Click OK. A new variable DesignVars appears in Design Optimization
Workspace of the Design Optimization tool. You can click the variable to view its
contents in the Variable Preview area.

w Desigh Optimization Workspace

Mame = Walue

UHiDesi griars

<3x1 para..

w Variable Prewview

DesigmWVars(l,l) =

Hame: ‘'KEd'
Value: 0
Minimum: 0
Maximum: Inf
Free: 1
Soale: 1
Info: [lxl struct]
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Optimize Model Response

Before you begin this task, you must have already specified the design requirements and
design variables as described in “Specify Step Response Requirements” on page 3-5,
and “Specify Design Variables” on page 3-8, respectively.

1

. Plot Current Response
(Optional) View the current response of the model. Click E . .

sldo_modell fCheck Step Response Update block
Characteristics

Amplitude

) ) O N TS SRS TSSO SN SUUUS IS SRS R
o a3 10 15 20 25 30 35 40 45 a0

Time [seconds)

The plot shows that the model output does not meet the specified step response
requirements.

2 Click Optimize.
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3 RESPOMSE QPFTIMIZATION

(\ﬁ’ @ Select E FlotCurrent Response IE
@ Options o
(\' f E Mew - E Add Plot = Dpt|m|l§

o _'{ . : ""-n-ﬂ..1]_:.2.-5.TIO M

An Optimization Progress window opens.

n Optimization Progress EI@

Iteration | F-count Check Step Response Characteristics (Upper)
(<=0}

Optimization started 08-Jan-2013 08:44:48

Save fieration.. | | Display Options...| | Stop Optimization |

Tip To view the model response and optimization progress windows simultaneously,

tile them using the plot layout area m

At each optimization iteration, the software simulates the model, and the default
optimization solver Gradient descent (Fmincon) modifies the design variables to
reduce the distance between the simulated response and the design requirement line

3-13



3 Response Optimization

segments. For more information, see “Selecting Optimization Methods” and “How the
Optimization Algorithm Formulates Minimization Problems”.

After the optimization completes, the optimization progress window resembles the
next figure.

u Optimization Progress EI@
Iteration | F-count Check Step Response Characteristics (Upper)
(==0)
0 5 431.9566
1 13 58.5409
2 21 336186
3 3 17.7437
4 35 3.1353
5 57 3.1368
[ 76 3.1495
T 95 3.1556
8 107 1.7116
5 115 0.2530
10 123 0.0824
Cptimization started 08-Jan-2012 08:44:48 -~
Optimization converged, 08-Jan-2013 08:45:23
Cptimized variable values written to "DesignVars’ in the Design Optimization workspace =
[ Save Iteratinn...] [ Display Options... ] [ Optimize

The message Optimization converged indicates that the optimization solver
found a solution that meets the design requirements within the tolerances and
parameter bounds. For more information about the outputs displayed in the
optimization, see “Iterative Display” in the Optimization Toolbox documentation.

3 Verify that the model output meets the step response requirements.
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sldo_model fCheck Step Responsze
Characteristics

1271
06--|
o 1
= !
E]
= 1
g 04+-4
02-|-
0l
(1) 21| I DU WU SN SN BUSUUNUUIN USSUNU AUUUUU RSN SO
0 5 10 15 20 25 30 35 40 45 50

Time (seconds)
The plot displays the last five iterations. The final response using the optimized
parameter values appears as the thick line.

The optimized response lies in the white region bounded by the design requirement
line segments and thus meets the requirements.

4 View the optimized parameter values. Click DesignVars in Design Optimization
Workspace and view the updated values in the Variable Preview area.

The optimized values of the design variables are automatically updated in the
Simulink model.

Save the Session

After you optimize the model response to meet design requirements, you can save the
Design Optimization tool session which includes the optimized parameter values.
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1  Click the Design Optimization tab of the Design Optimization tool.

2 In the Save drop-down list, select Save to model workspace.

DESIGHN OPTIMIZATION RESPOMSE OFTIMLZATIC

=1 Open - E

Save
Save SDOTOOL Session

Response

Save to model workspace

Save to base workspace

A window opens where you specify the session name.

Save to Simulink rmodel warkspace

Existing Session YWariables

L [do_rmodell sdosess

| ok || cancel || Help |

3  Specify a session name in the Session field.

Click OK.

Tip To open the saved session, click the Open from model workspace option in the
Open drop-down list of the Design Optimization tool for the model.
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Related Examples

Related Examples

* “Design Optimization to Meet Step Response Requirements (Code)”
* “Design Optimization to Track Reference Signal (GUI)” on page 3-25
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Design Optimization to Meet Step Response Requirements (Code)

3-18

In this section...

“Model Structure” on page 3-18

“Design Requirements” on page 3-19

“Specify Step Response Requirements” on page 3-19
“Specify Design Variables” on page 3-20

“Optimize Model Response” on page 3-20

This example shows how to programmatically optimize controller parameters to meet
step response requirements using sdo.optimize.

Model Structure

The model sldo_model 1 includes the following blocks:

'—’ FID | Int Outt

Unit Step

Controller Plant

+ Controller block, which is a PID controller. This block controls the output of the
Plant subsystem.

* Unit Step block applies a step input and produces the model output that should
meet step response requirements.

You can also use other types of inputs, such as ramp, to optimize the response to meet
step response requirements generated by such inputs.

* Plant subsystem is a second-order system with delay. It contains “Transfer
Function” and “Transport Delay” blocks.

: winz2 > % —.'(Ij

I sZ+ 2w zetas+wlh2 outl
Transport Delay

Transfer Fon
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Design Requirements

The plant output must meet the following step response requirements:

* Rise time less than 2.5 seconds
+  Settling time less than 30 seconds

*  Overshoot less than 5%

Specify Step Response Requirements

1  Open the Simulink model.

sys = "sldo_modell";
open_system(sys);

+ o .
: FiD »In Cut
Unit StEp

Controller Plant

2 Log the model output signal.

Design requirements require logged model signals. During optimization, the model is
simulated using the current value of the model parameters and the logged signal is
used to evaluate the design requirements.

PlantOutput = Simulink._SimulationData.SignalLogginglinfo;
PlantOutput.BlockPath [sys "/Plant™];
PlantOutput.OutputPortindex 1;
PlantOutput.LoggingInfo.NameMode 1;
PlantOutput.LoggingInfo.LoggingName "PlantOutput”;

3  Store the logging information.

simulator = sdo.SimulationTest(sys);
simulator.Logginglnfo.Signals = PlantOutput;

simulator is a sdo.SimulationTest object that you also use later to simulate the
model.

4  Specify step response requirements.
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StepResp = sdo.requirements.StepResponseEnvelope;
StepResp.-RiseTime = 2.5;

StepResp.-SettlingTime = 30;
StepResp.PercentOvershoot = 5;

StepResp is a sdo.requirements.StepResponseEnvelope object.

Specify Design Variables

When you optimize the model response, the software modifies parameter (design
variable) values to meet the design requirements.

1

Select model parameters to optimize.
p = sdo.getParameterFromModel (sys,{"Kp", "Ki","Kd"});

p is an array of 3 param.Continuous objects.

To limit the parameters to positive values, set the minimum value of each parameter
to O.

p(1) -Minimum = 0;
p(2) -Minimum = 0;
p(3) -Minimum = 0;

Optimize Model Response

1

3-20

Create a design function.
evalDesign = @(p) sldo_modell_design(p,simulator,StepResp);

evalDesign is an anonymous function that calls the cost function
sldo_modell_design. The cost function simulates the model and evaluates the
design requirements.

Tip Type edit sldo_modell_design to view this function.

(Optional) Evaluate the current response.
a Compute the model response using the current values of the design variables.

initbDesign = evalDesign(p);
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During simulation, the Step Response block throws assertion warnings at the
MATLAB prompt which indicate that the requirements specified in the block are
not satisfied.

b Examine the nonlinear inequality constraints.
initDesign.Cleq
ans =

-0.2571
-0.4968
-0.5029
-1.0000
0.7060
0.5092
0.4964
201.4682

Some Cleq values are positive, beyond the specified tolerance, indicating
that the response using the current parameter values violates the design
requirements.

Specify optimization options.

opt = sdo.OptimizeOptions;
opt_MethodOptions.Algorithm = "active-set”;

The software configures opt to use the default optimization method, fmincon.
However, because the optimization problem specifies only constraints, you specify
the Active Set algorithm for fmincon. The Active Set algorithm is good for solving
feasibility (constraints only) optimization problems.

Optimize the response.
[pOpt,optinfo] = sdo.optimize(evalDesign,p,opt);

At each optimization iteration, the software simulates the model, and the default
optimization solver fmincon modifies the design variables to meet the design
requirements. For more information, see “Selecting Optimization Methods” and
“How the Optimization Algorithm Formulates Minimization Problems”.

After the optimization completes, the command window displays the following
results:
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max Step-size First-order
Iter F-count f(x) constraint optimality
0 5 0 201.5
1 12 0 167.5 0.687 0
2 19 0 0.8462 1.22 5.86
3 29 0 0.8169 0.133 0
4 37 0 0.7819 0.115 0
5 44 0 3.121 0.265 3.29
6 52 0 3.328 2.92 0
7 59 0 0.1413 1.26 2.81
8 66 0 0.02418 0.443 0.0029
9 73 0 8.125e-05 0.0563 1.03e-05

Local minimum found that satisfies the constraints.

Optimization completed because the objective function is non-decreasing in
feasible directions, to within the selected value of the function tolerance,
and constraints are satisfied to within the selected value of the constraint tolerance.

The message Local minimum found that satisfies the constraints
indicates that the optimization solver found a solution that meets the design
requirements within specified tolerances. For more information about the outputs
displayed during the optimization, see “Iterative Display” in the Optimization
Toolbox documentation.

Examine the optimization termination information, contained in the optinfo
output argument. This information helps you verify that the response meets the step
response requirements.

For example, check the following fields:

+ Cleq, which shows the optimized nonlinear inequality constraints.
optinfo.Cleq
ans =

0.0001
-0.0099
-0.0099
-1.0000

0.0004
-0.0100
-0.0101
-0.1997

All values satisfy Cleq < 0, within the optimization tolerances, which indicates
that the step response requirements are satisfied.

+ exitflag, which identifies why the optimization terminated.
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6

The value is 1 which indicates that the solver found a solution which was less
than the specified tolerances on the function value and constraint violations.

View the optimized parameter values.

pOpt
popt(1,1) =
Name: “Kp*
Value: 1.2364
Minimum: O
Maximum: Inf
Free: 1
Scale: 1
Info: [1x1 struct]
popt(2,1) =
Name: "Ki*
Value: 0.3901
Minimum: O
Maximum: Inf
Free: 1
Scale: 1
Info: [1x1 struct]
popt(3,1) =
Name: "Kd*
Value: 2.5937
Minimum: O
Maximum: Inf
Free: 1
Scale: 1
Info: [1x1 struct]

Simulate the model with the optimized values.

a Update optimized parameter values in the model.

sdo.setValuelnModel (sys,pOpt);
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b Simulate the model.

sim(sys);

See Also

sdo.requirements.StepResponseEnvelope | param.Continuous |
sdo.getParameterFromModel | sdo.optimize | sdo.OptimizeOptions |
sdo.SimulationTest | Simulink.SimulationData.SignalLogginglnfo

Related Examples

“Design Optimization to Meet Step Response Requirements (GUI)” on page 3-4
“Design Optimization to Track Reference Signal (GUI)” on page 3-25
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Design Optimization to Track Reference Signal (GUI)

In this section...

“Model Structure” on page 3-25

“Design Requirements” on page 3-26
“Specify Reference Signal” on page 3-26
“Specify Design Variables” on page 3-33

“Optimize Model Response” on page 3-36

This example shows how to optimize controller parameters to track a reference signal
using the Design Optimization tool. You specify the reference signal without adding any
Check blocks to the model.

Model Structure

The model sldo_model 1l includes the following blocks:

¥ i 7
D |—’. FID | In Out

Unit Step

Controller Plant

+  Controller block, which is a PID controller. This block controls the output of the
Plant subsystem.

+  Unit Step block applies a step input and produces the model output that should
meet step response requirements.

You can also use other types of inputs, such as ramp, to optimize the response to meet
step response requirements generated by such inputs.

+  Plant subsystem is a second-order system with delay. It contains “Transfer
Function” and “Transport Delay” blocks.
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: winz2 - > % _.":Ij

I sZ+ 2w zetas+wlh2 ot

Transport Delay

Transfer Fon

Design Requirements

The model output must track a reference signal y =1-exp(-0.1x?), where ¢ is time.

Specify Reference Signal
1  Open Simulink model.

sys = "sldo_modell";
open_system(sys);

¥ wlica r
Q i—“. FID »In out

Contraller Plant

To learn more about the model, see “Model Structure” on page 3-25.

2 In the Simulink model window, select Analysis > Response Optimization.

A Design Optimization tool for the model opens.
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Search workspace variables

w MATLAB Workspace

Value

‘sldo_meod...

Value

0
0

1
5000

w Design Optimization Workspace

MName = Value

w Variable Preview

3 Select the model signal which must track the reference signal.

a Inthe New drop-down list, select Signal.
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L New v | [ AddPlot =
I New Requirement

=

=]

Q=

=

<E

Signal Bound
Usze to spacify a piecewise
linear bound on a signal.

Step Response Envelope
Use to specify a step
response envelope on a signal.

Signal Tracking
Use to specify a tracking
requirernent on a signal,

Custom Requirement
Use to create 3
custom requirement,

New Requirement Using Model Blocks

Time Domain Check Blocks
Use the Sirnulink Cesign Optimization library b
add time domain check blocks to a Simulink. maodel,

Frequency Domain Check Blocks
Usze the Simulink Control Design library to add
Frequency domain check blocks o a Simulink madel,

Signal
Specify Simulink Signals to log so h
they can be used in design requirements,

A window opens where you select a model signal.

!

Signal set: m

Mo signals have currently been
selected. Please go back to the
model and didk on a signal to
select it.

Signal

L 4

Remove Signal

| ok || cancel || Help |
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b In the Simulink model window, click the output of the Plant block.

The window updates to display the selected signal.

Signal set: |Sig |

@ Currently selected signals Signal
[ sldo_modell/Plant: 1

| Rermove Signal |

| oK || cancel || Help |

Select the signal and click to add it to the signal set.

Signal set: |Sig |

L~—"" Signal
ldo modell/Plant:l )

\______-#_/

@ Currently selected signals
W o

| Rermowe Signal |

| ok || cancel || Help |

d In Signal set, enter PlantOutput as the selected signal name.
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Click OK. A new variable PlantOutput appears in the Design Optimization
Workspace of the Design Optimization tool.

4  Specify the reference signal that the model output must track.

a Inthe New drop-down list, select Signal Tracking.

' Design Optimization® - sldo_modell

DESIGN OPTIMIZATION RESPONSE OPTIMEZATION

Design Variables Set: @ Mone = E Hew ~ ﬁ
MEW TIME DOMAIN REQUIREMENT

Uncertain Variables Set: None | =
Signal Bound

VARIABLES | @ specify a piecewise
@ E ® EE linear bound on a signal.

Dato Browser

Signal Property
Specify a requirement on a signal
property such as the mean value.

Searchworkspace variables

w MATLAE Workspace

Step Response Envelope

o
ame - alas E Specify a step
sys
i

.
sldo_med... response envelope on a signal.

Signal Tracking
Specify a tracking %
w* Model Workspace (sldo_modell) requirement on a signal.
MName Value Custom Requirement

Create a

- kd 0

W custom requirement.

A window opens where you specify the reference signal.

F|p

\
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b
c

d

Signal Tracking

Specify a tracking requirement on a signal.

Name:

w Specify Reference Signal
Time vector: [0:1:2:3:4:5:6:7:8:910]
Amplitude:

[0;0.632120558828558,0.864664716763387,0.95021 29316321 36,0.98168436111

Update reference signal data

Tracking Method: SSE »

w Specify Signal to Track Reference Signal

Signal
PlantQ Id dell/Plant:1
= antOutput (sldo_modell/Plant1)
/
[¥] Create Plot [ 0] ” Cancel ][ Help l

In the Name edit box, enter ref_sig.
In the Time vector edit box, enter 1 inspace(0,50,200)
In the Amplitude edit box, enter 1-exp(-0.1*linspace(0,50,200)).
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Signal Tracking

Specify a tracking requirement on a signal.

Mame: |ref_sig

w Specify Reference Signal

Time vector: linspace(0,50,200)

Amplitude: 1-exp(-0.1%linspa cel{ﬂ,Sﬂ,lUU]]l

The Tracking Method is SSE, which means that at each optimization iteration,
the solver attempts to reduce the sum of squared errors between the simulated
output and reference signal.

Click Update reference signal data.

Select the check-box corresponding to the signal you selected in the previous
step in the Specify Signal to Track Reference Signal area.

racking Method: :SSE v:

w Specify Signal to Track Reference Signal

PlantOutput (slde_modell/Plant:1}

Click OK. A new variable ref_sig appears in the Design Optimization
Workspace and the Design Optimization window updates to plot the reference
signal.
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FLOT

sldo_madel Plant:1
T T T T T

T T s T 1
e ;
- :

: L

Tirme (Seconds)

Specify Design Variables

Before you begin this task, specify the reference signal to track as described in “Specify
Reference Signal” on page 3-26.

When you optimize the model response, the software modifies the design variable (model
parameter) values to meet the design requirements.

In the Response Optimization tab:

1

Select New in the Design Variables Set drop-down list.
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DESIGN OPTIMIZATION RESPOMSE OFTIMIZATION

i::] Mone / @ Select E FlotCurrent Response

Create Mew Set of Design Yariables

Design Wariables Set:

Uncertain Wariahles Set: Add Plot =

MNew...
I{IF Uze to specify wariables used
WARIABL by the Sirmulink model bo optimize

PLOTS

A window opens where you specify design variables.

Create Design Variables set:

] I Variable IVaIueI Mi”"'l Max.‘.l Scale E] Variable Current value Used By
Kd D
* Ki 0
' Kp 13
wi 0.5
et 05
Update model variable values pets

» Variable Detail » Specify expression (e.q., s.x or a(3))

Click Kd, Ki and Kp to select them.

Click E to add the selected parameters to a design variables set.

Create Design Wariables set: |Design‘u‘ar5 |

“ariahle Yalue Minimum | Maximum Scale
kd 0 -Inf Inf 1
Ki I -Inf Inf 1
kKp 1 -Inf Inf 1

The software displays the following parameter settings:

* Variable — Parameter name
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* Value — Current parameter value
* Minimum and Maximum — Parameter bounds

* Scale — Scaling factor for the parameter

The check-box indicates that the parameter is included in the design variable set.
The default design variable set name is DesignVvars.

To limit the parameters to positive values, enter the minimum value of each
parameter as O in the corresponding Minimum field and press Enter.

Create Design Variables set: | DesignVars

Variable Value | Minimum | Maximum Scale
Kd ] ] Inf 1
Ki 0 ] Inf 1
Kp 1 ] Inf 1

Click OK. A new variable DesignVars appears in Design Optimization
Workspace of the Design Optimization tool. You can click the variable to view its
contents in the Variable Preview area.

w Desigh Optimization Workspace

Mame = Walue

UHiDesi griars

<3x1 para..

w Variable Prewview

DesigmWVars(l,l) =

Hame: ‘'KEd'
Value: 0
Minimum: 0
Maximum: Inf
Free: 1
Soale: 1
Info: [lxl struct]
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Optimize Model Response

Before you begin this task, you must have specified the reference signal to track and
design variables, as described in “Specify Reference Signal” on page 3-26 and “Specify
Design Variables” on page 3-33, respectively.

1
E. Plot Current Response

(Optional) View the current model response. Click

sldo_modell /Plant:1

Amplitude

Time [seconds)

The plot shows that the response does not track the reference signal.

2 Click Optimize.
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3 RESPOMSE QPFTIMIZATION

(\ﬁ’ @ Select E- FlotCurrent Response IE
@ Options o
(\' Z E Mew - E Add Plot = Dpt|m|l§

o _'{ . : ""-n-ﬂ..ﬂ_:.Z.-!-.TIO M

An optimization progress window opens.

Tip To view the model response and optimization progress windows simultaneously,

tile them using the plot layout area m

At each iteration, the optimization solver Gradient descent (fmincon) modifies
the controller parameters to minimize the error between the simulated response
and the reference signal. To learn more, see “How the Optimization Algorithm
Formulates Minimization Problems”.

After the optimization completes, the optimization progress window resembles the
following figure.
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B Optimization Progress E=5 BoB =<5
Iteration | F-count ref_sig
(min)
0 5 301 -
1 34 24 6€
2 43 21.38
3 51 1.65=
4 g2 1.45
5 T 0.57
13 82 051
i 50 0.3€
2 93 0.3
a2 106 0.3
10 114 0.3
11 122 031 -
4| 1 §
COptimization started 08-Jan-2013 09:48:55 -~
[ —
Optimization converged, 08-Jan-2013 09:49:34
Cptimized variable values written to "DesignVars’ in the Design Optimization workspace L
[ Save rteratiun...] [ Display Options... ] [ Optimize ]

The message Optimization converged indicates that the optimization method
found a solution that tracks the reference signal within the tolerances and
parameter bounds. For more information about the outputs displayed in the
optimization progress window, see “Iterative Display” in the Optimization Toolbox

documentation.

3  Verify that the response tracks the reference signal.
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PlantQutput  =| Optimization Progress =

sldo_model Flart:1

Amplitude

Time (=econds)

The optimized response closely tracks the reference signal.

4 View the optimized parameter values. Click DesignVars in Design Optimization
Workspace and view the updated values in the Variable Preview area.

The optimized values of the design variables are automatically updated in the
Simulink model.

Related Examples

* “Design Optimization to Meet Step Response Requirements (GUI)” on page 3-4
+ “Design Optimization to Meet Step Response Requirements (Code)” on page 3-18
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Design Optimization Using Frequency-Domain Check Blocks (GUI)

In this section...

“Model Structure” on page 3-40

“Design Requirements” on page 3-41
“Specify Design Requirements” on page 3-41
“Specify Design Variables” on page 3-44
“Optimize Design” on page 3-46

This example shows how to optimize a design to meet frequency-domain requirements
using the Design Optimization tool. Simulink Control Design software must be installed
to optimize a design to meet frequency-domain design requirements.

In this example, you specify the design requirements in a Check Bode Characteristics
block and optimize a rectifier filter parameters to meet gain and bandwidth
requirements, and minimize a custom objective.

Model Structure

The model sdorectifier includes the following blocks:

Lyﬂ

Source Fulbw ave oliage
R ectifier Rectifier Filter

Fitter Design Requirements

+ Full-Wave Rectifier block — An Abs block

* Rectifier Filter subsystem — RLC filter implemented using integrator and gain
blocks

* Filter Design Requirements block — Check Bode Characteristics block that
specifies the gain and bandwidth design requirements
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Design Requirements

The design optimization problem is multi-objective. The design must:

* Have a —3db bandwidth of at least 2Hz

*  Limit the gain across the frequency range 2Hz—60Hz to at most 0db
*  Limit the gain above 60Hz to at most —20db

* Maximize the filter resistance R

*  Minimize the filter inductance L

The requirements ensure that the rectifier filter combination has minimal high frequency
content, responds quickly to voltage changes, and limits filter currents.

Specify Design Requirements

1 Open the Design Optimization tool for the model.

sdotool ("sdorectifier®)
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4\ Design Optimization” - sdorectifier - Bode plot 1 EI@
DESIGN OPTIMIZATION RESPONSE OPTIMIZATION FIGURE VIEW r

Design Variables Set: None + i New ~ LE Ty s n r@. I> %

' Options
- Evaluate [€] No data selected ~  Add Plot  Plot © it @ imi;
Uncertain Variables Set: [ None ~ [ Select  Requirements €l e Rﬁp:'r:: Soipze cg;e
VARIAELES REQUIREMENTS FLOTS OFTIMIZATION CLOSE
=RON~
Data Browser ® Bodeplotl =

Search waorkspace variahles

w MATLAB Werkspace

':..f..'| There is no data for sdorectifier/Filter Design Requirements, use “Flot Cumrent Response™ or run the optimization to update the plot.

sdorectifier/Filter Design Requirements
Mame Value i

w» Model Workspace (sdorectifier)

M agnitude (dB)
=
T

Mame Value :
(Hc 5.0000e-04 T O
L 0.0500
HH R 25
-20
1
w Design Optimization Workspace
MName Value 03
@ 06
=
H
E 04
o
w Variable Preview
0zF
o ; 5 : - \
10° 10 10 10 10

Freguency (radis)
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The plot shows the gain and bandwidth requirements specified in the Fi lter
Design Requirements block. See their values in the Bounds tab of the Block
Parameters dialog box.

2 Specify a custom objective to minimize the filter inductance and maximize the
resistance.

The custom objective is specified in the sdorectifier_cost function. The function
accepts the design variables R and L, and returns the objective to be minimized.

Tip Type edit sdorectifier_cost to view this function.
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Select Custom Requirement in the New drop-down list.

@ Select E PlotCurrent Response

@
iNew v [ AddPot v

Mew Requirement

o

Signal Bound
@ Use to specify a piecewize
linear bound on 2 signal,

Step Response Envelope
Use bo specify a step
responze envelope on a signal,

signal Tracking

=]
@ Uze bo specify a tracking
=

requiremnant on a signal,

Custom Requirement
Uze to create a
custom requirement,

A window opens where you specify the custom requirement.

Custom Requirement

Use to create a customn requirement. The optimizer will call the specified function handle
during optimization passing a structure with fields containing
the current design variable values and the selected simulation signal values,

Requirement Name: m

Requirernent function: | @myCustomRequirement

Requirement type: (P

Specify the following:

*  Enter MaxMinRL in Requirement Name

+ Enter @sdorectifier_costin Requirement function. The optimization

solver calls the specified function handle.

+ Select min in Requirement type

3-43



3 Response Optimization

3-44

Custom Requirement

Use to create a cuskom requirement, The optimizer will call the specified function handle
during optimization passing a structure with fields containing
the current design wariable walues and the selected simulation signal walues,

Requirernent Mame: | MaxiinRL

Requirernent function: | sdorectifier_cost

Requirernent type:

Select Model Signals

ignal

[ f

Click OK. A new variable MaxMinRL appears in Design Optimization
Workspace of the Design Optimization tool.

Specify Design Variables

Before you begin this task, specify the design requirements as described in “Specify
Design Requirements” on page 3-41.

When you optimize the model response, the software modifies the design variable
(parameter) values to meet the design requirements.

1 Select New in the Design Variables Set drop-down list.

DESIGN OPTIMIZATION RESPOMSE QOFTIMIZATION

Design Wariables Set: i:j Mone / @ Select E PlotCurrent Respaonse

Create Mew Set of Design ¥Yariables

Uncertain YWariables Set: 4cld Plot =
Mew...
— l{::l Ize to specify variables used
WARIABEL by the Sirmulink rmodel to optirize PLOTS L
— RP—

A window opens where you specify design variables.
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Create Design Variables set: |[B2

I ariable I Valuel Min...I Max...l Scale

[:] Wariahle Currentvalue Used By
C 0.0005

dorectifier/Rectifier

L .03 dorectifier/Rectifier
| | R 25 dorectifier/Rectifier

s
ol

P ariable Detail

Update model variable values |

P Specify expression {e.g., sx or a(3))

[ ok |[ cancel |[ Help |

Click R, L and C to select them.

Click E] to add the selected parameters to a design variables set.

Specify the value range for each design variable:

R in the range 1-50 ohms
L in the range 1-500mH
C in the range 1pF-1mF

Because the variables are different orders of magnitude, specify scaling factors in
the corresponding Scale column of the variables:

* Rby25
+ Lby0.05
+ C by 0.0005

Create Design Variables set: | Designtfars

Wariahle Minimum | Maximum
C 1.0005
L 0.05 le-3 S00e-3 0.5
R 25 1 a0 25
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Click OK. A new variable DesignVars appears in Design Optimization
Workspace of the Design Optimization tool.

Optimize Design

Before you begin this task, you must have already specified the design requirements and
design variables, as described in “Specify Design Requirements” on page 3-41 and
“Specify Design Variables” on page 3-44, respectively.

1

\ Plot Current Respanse
(Optional) View the current response of the model. Click E : .
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sdarectifierFiter Design Reguirements

hagnitude (dB)

Phaze (deg)

10" 10°
Freguency (radiz)

The plot shows that the model does not meet the specified gain and bandwidth
requirements.

You also see that the filter voltage signal overshoots its steady-state value and
contains significant harmonic content in the Voltage scope window.
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o

n"u"critage El@ﬁ
2aB|(Qsk ENRBDasw -

0. I:I: .04 0.0& .03

2 Click Optimize.

\> RESPOMSE QOFTIMIZATION

Qa\ff @ Select E FlotCurrent Response IE

“ y’ E Mew - E Add Plot = Optimize

& ’—-- ] ‘/\h”.....IIIHMIE'&'HOH h

An optimization progress window opens.

@ Options

After the optimization completes, the optimization progress window resembles the
next figure. After a few iterations, the optimization converges to satisfy the filter
bandwidth requirements.
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o "

n Optimization Progress EIIEI

Tteration | F-count MaxMinRL Filter Design Requireme... | Filter Design Requireme...
(min) (==0) (>=0)
0 & 1.1000 8.1361 1.0067
1 16 0.3519 -0.8514 -0.8115
2 23 0.0420 0.9941 1.0000
3 I 0.0683 0.2360 0.9654
4 39 0.0754 0.0451 0.89415
3 45 0.0340 0.0058 0.9342
6 a3 0.0240 0.0058 0.9342

Optimization started 08-Jan-2013 10:07:11 -
=
Optimization converged, 08-Jan-2013 10:07:48
Optimized variable values written to "DesignVars’ in the Design Optimization workspace e
[ Save teration...| |Display Options...| |  Optimize |

The filter voltage signal in the Vol tage scope window also settles to within its
steady-state value in around 0.08 seconds without any overshoot and the harmonic
content is significantly reduced from the initial design.
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o

B Votage =)
ap @R | %% 08 % -

02 .04 .0 .03

3 Verify that the model meets the gain and bandwidth requirements.

3-50



Design Optimization Using Frequency-Domain Check Blocks (GUI)

[sdoRectiﬁer,-‘FiIterDesig... % | Optirmization Progress %

Updste kic

soloRectifierFiter Design Reguirements

Magnitude (dE])

Phase (deq)

Freguency (radis)

The plot displays the last five iterations. The final response using the optimized
parameter values appears as the thick line.

The optimized response lies in the white region bounded by the design requirement
line segments and thus meets the requirements.

Click DesignVars in Design Optimization Workspace and view the updated
values in the Variable Preview area.

The optimized values of the design variables are automatically updated in the
Simulink model.
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Time-Domain Model Verification

3-52

This example shows how to perform time-domain model verification using Simulink
Design Optimization Model Verification blocks. During time-domain verification, the
software monitors a signal to check if it meets time-domain characteristics such as step
response characteristics and upper and lower amplitudes, or tracks a reference signal.

You can also use blocks from Simulink and Simulink Control Design Model
Verification libraries to design complex assertion logic for time- and frequency-domain
verification, and signal monitoring. If you have Simulink Verification and Validation
software, you can construct simulation tests for your model using the Verification
Manager tool in the Signal Builder.

1 Open Simulink model.

sys = "sldo_modell_stepblk™;
open_system(sys);

+ o .
i—’ FiD »In Cut

Unit StEp I—
Controller Plant s

Step Response

¥

The model includes a Step Response block which is a Check Step Response
Characteristics block from the Simulink Design Optimization Model Verification
library and has default step response bounds.


http://www.mathworks.com/products/simverification/

Time-Domain Model Verification

Sink Block Parameters: Check Step Response Characteristics @
Check Step Response Characteristics

Assert that the input signal satisfies bounds specified by step response characteristics.

Bounds | Assertion

Include step response bound in assertion

Step time (seconds): 0

Initial value: 0 Final value: 1
Rise time (seconds): 5 % Rise: 80
Settling time (seconds): 7 % Settling: 1
% Owvershoot: 10 % Undershoot: 1

Enable zero-crossing detection

Show Plot | [C] Show plot on block open lResponse Optimization...

\} [ OK H Cancel ” Help Apply

2 In the Simulink Editor, click Simulation > Run.

The block asserts multiple times during simulation because the signal to which the

block is connected violates the specified bounds. Assertion warnings appear in the
MATLAB command window.

You can optimize model parameters to satisfy the bounds and eliminate assertion

warnings. See “Design Optimization to Meet Step Response Requirements (GUI)” on
page 3-4.
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Optimization-Based Linear Control
Design

* “When to Use Optimization-Based Linear Control Design” on page 4-2

* “Types of Time- and Frequency-Domain Design Requirements for Optimization-Based
Control Design” on page 4-3

* “Quick Start — Optimization-Based Linear Control Design” on page 4-4

* “Design Optimization-Based PID Controller for Linearized Simulink Model (GUI)” on
page 4-15



4 Optimization-Based Linear Control Design

When to Use Optimization-Based Linear Control Design

When you have Control System Toolbox software installed, you can design and optimize
control systems for LTI models by optimizing controller parameters in the SISO

Design Tool. To use optimization methods for linear control design, also known as
optimization-based tuning, you must already have an initial controller. You can then
use optimization-based tuning to refine the controller design to meet additional design
requirements. For more information on designing controllers, see the Control System
Toolbox documentation.

Note: Optimization-based tuning only changes the value of the controller parameters and
not the controller structure itself.

Optimization-based tuning provides flexibility in terms of specifying additional design
requirements for the controller. When you have a large number of design requirements,
you can first design an initial controller by selecting a subset of requirements and
subsequently select additional requirements to refine the design.

Optimization-based tuning also provides flexibility in terms of selecting a subset of
controller parameters to optimize, and specifying bounds on the controller parameters.

To design linear controllers for Simulink models using optimization-based tuning,
you must first linearize the model using the Simulink Control Design software. For
more information on linearizing Simulink models, see the Simulink Control Design
documentation.



Types of Time- and Frequency-Domain Design Requirements for Optimization-Based Control Design

Types of Time- and Frequency-Domain Design Requirements for
Optimization-Based Control Design

When you design linear controllers for LTI or Simulink models using the Simulink
Design Optimization software, you can specify both time- and frequency-domain
requirements on the system response. You can specify design requirements on the
following plots:

*  Root Locus plot

*  Open-Loop and Prefilter Bode plots
*  Open-Loop Nichols plot

+  Step/Impulse Response plots

For more information, see “Time- and Frequency-Domain Requirements in SISO Design
Tool”.

Simulink Design Optimization software uses the frequency-domain requirements to
compute the frequency response of the system. It then uses optimization methods to
reduce the distance between the current response and the requirements by modifying
the controller parameters. The software does not change the controller structure when
optimizing the controller parameters.

4-3



4 Optimization-Based Linear Control Design

Quick Start — Optimization-Based Linear Control Design

4-4

In this quick start, you get an overview of the typical tasks for optimization-based linear
control design using the SISO Design Tool:

Open a SISO Design Tool session.

Configure a project for optimization-based control design.

Specify the controller parameters to design.

Specify the design requirements.

Design the controller.

o O A W NN —

Evaluate the controller design.

Note: The same workflow applies to optimization-based control design for LTI models
created at the command line using Control System Toolbox software. To learn how

to create LTI models, see “Linear (LLTT) Models” in the Control System Toolbox
documentation.

Prerequisites for optimization-based linear control design include:

+  Simulink Compensator Design Task that contains a linearized version of the Simulink
model and, optionally, any response plots you configure.

For more information on how to linearize a Simulink model for control design, see the
Simulink Control Design documentation.

* Time- and frequency-domain design requirements
To design a controller using optimization methods:

1 Open a SISO Design Tool session by typing the following command at the MATLAB
prompt:

sisotool ('projectname.mat')



Quick Start — Optimization-Based Linear Control Design

=] Control and Estimation Tools Manager (=] 79|
File Help
=hall=0"]
4& Workspace [Project Settings
ISR~ Project - sido_model2 _ —
Operating Points Title: IPro]ect - sldo_model2
SISO Design Task =2] iilmulink Compensator De | gpee . [
for SISO DeS|gn —_— J SISO Design Task
Tool Created by: |
Date modified: ~ 10-Nov-2008
Simulink model:  sldo_model2
Description: ;]
|
4 | ©
2
]
Project node. 4

The command also opens a SISO Design for SISO Design Task window by default
and any response plots you configured when you linearized the Simulink model using
Simulink Control Design software.

Configure a project for optimization-based control design by clicking Optimize
Compensators in the Automated Tuning tab of the SISO Design Task.
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-loix

File Edit Tools Help

gllagd|2 &

0 Workspace

=} E_l Project - sldo_model2

o) Operating Points

= Simulink Compensator De
B

SISO Design Task

-Optimization Based Tuning

Architecture | Compensator Editar | Graphical Tuning | Analysis Plots Autemated Tuning |
Design method: ]Optimization Based Tuning ~1

Ll

You can use optimization-based tuning to create an initial compensator design or to refine the current compensator
de:

sign:

Bode, Nichols, or Step N thods to

ta satisfy the design requirements. Compensator elements that are tunable via optimization-based tuning include
gains, poles, and zeros.

specify design requi For your system by positioning bounds on design or analysis plots such as.
Then, imization-based met tunz

Requires the Simulink Design Optimization product.

Optimize Compensators. ., |

7 l _’_l Staore Design Update I~ A update block Help |
=
SISO Design Task Node. 7

Method for
controller
design

This action creates a new Response Optimization node in the Control and
Estimation Tools Manager.
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=] Control and Estimation Tools Manager —lof x|
File Edit Tools Help

gOad|9 o

. worlspace Overvien | Compensatars | Design requirements | Optimization |
-] Project - sldo_madel2

~Overview
Operating Points
B+ Simulink Compensator Design
£ 5150 Design Task | |
Design Histary I I
Design Operating Pair Step 1 } Siep 2 : Step 3
s izatio} ] 1
I Set optimization I
} aptions :
I 1
Select ] I
COMPENsalors o 1 ]
optimize I 1
I 1
] 1
I 1
Optimize - View resulls
I 1
] 1
] 1
Selact design | 1
requirements } :
] 1
I 1
I 1

4 _,l Start Optimization Help

4
=
A

Response Optimization

Specify the controller parameters to design in the Compensators tab.



4 Optimization-Based Linear Control Design

Right-click to change

Select parameters controller parameters (Optional) Specify

to optimize representation to Simulink jnitial value (Optional) Specify
block mask parameters

parameter bounds
| ]

ontrol and ation Too anage -olx]
File Edit Tools Help
gD |cd|2
4\ Workspace Overvign Compensators | Design requiremgnts | Optimization |
S| _G_] Project - sldo_modelZ | “gaject ot elements to optimize
(L} Operating Points — - - L -
B Simulink Compens I~ Optimize Compensator element I Value ‘ Initia guessl Minimum Maximum I Typical value
B ﬂ SISO Design” [ sldo_model2/Controller
#-[[7) Design Hi | & Gain I F
|z Design Q) ||} Real Zero -Inf Inf
B cspons [m] Real Zero Inf I
[ml Real Pale -Inf Inf -100
Right click on a compensator name to change its reprasentation, =
Use Value as Initisl Guess I
Jq | i Start Optimization | Help |
e
=
Response Optimization Z

4  Specify the design requirements.
a Inthe Design requirements tab, click Add new design requirement.

Specify the design requirements, for example Bode magnitude lower limit, in the
New Design Requirement dialog box.
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1] Control and Estimation Tools Manager
Fie Edt Tools Help

) New Design Requirement =10 x|

ioixil

Requirement

gn|cd|9 —
et 3ode magnitude lower limit
4 orkspace Overview | Conpensatars Desgnregurements | optnizaton | de magnitude lower limit typa
- BH Project - sldo_modsl2 0
(3 Operating Points for response: ... Loop from Unit Step to Controller v | dg—— Response
=[] simulink Compensator Design Task Response plot type
2% 5150 Design Task e yp
- ) Design History -
Design Operating Point. Segments:
) Response Optimization
Start End
Frequency | Magnitude | Frequency | Magnitude | Slope | Weight ||| lg— Requirement
il 0 10] 0 of 1 values
Insert Delete
oK Cancel | Help
e i
stonpits || Add
requirement
4 0| Start Optimization | Help

Response Optimization

In the SISO Design window, the yellow region with the black line segment
represents the design requirement on the response plot.
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4-10

) SIS0 Design for SISO Design Task

File Edit Wiew Designs Analysis Tools Window Help

=0l ]

ix o ¥ e

Open-Loop Bode Editor for Open Loog 1 (L1

a0 T T T T T T

Magnitude [dB)
i
(=]

G Inf
Freq: Inf
Stahle loop

-150

-45 T T T T

— a0
[=7]
o
E
L
[
2
£ 35 i
P M. 804 deg
Freg: 0.505 radizec
B0 b ey e e e o ] e e e e g
107 10" 107" 10" 10! 10° 107 10

Freguency (radizec)

Right-click on the plots for maore design options.

The Design Requirements tab also lists the design requirement.




Quick Start — Optimization-Based Linear Control Design

Lists all specified

Select the requirement
to enforce during
optimization design requirements
[=] control and Estimation Tools Manager =10f x|
File Edit Tools Help
o i = T
[\ Workspace Overvigw | Comp Dasign requi Ir imization |
& !‘ Project - sldo_model2 Select|design requirements to satisfy
Operating Points — =
& B Simulink or De ||| Optimize Response plot I Design requirement
= ﬂ SISO Design Task ] Open Loop at outport 1 of Controller
v Open-Loop Bode Editor for Open Loop 1 (L1) | Lower gain limit from 0.001 to 1 rad/sec

Design Operating
E ﬂ Response Optimi

#-[[7) Design History

Click the 'Add new design raquirement’ button or right click on 2 plot to add a new design requirement.
Show Plots | I i Add new design requirement... i}

Help |

Start Optimization |

R} 0
e
=
7|

BN

Unda
b Repeat step a to specify additional time- and frequency-domain requirements.

5 Start the optimization to design the controller by clicking Start Optimization in

the Optimization tab.
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=] Control and Estimation Tools Manager o [=] 2]

File Edit Tools Help
S0 cd|9

ﬂ Workspace Overview | Compensators | Design requirements Optimization l
= QJ Project - sldo_model2 ~Optimization progre
o) Operating Points
B Simulink Compensator Iteration Eval-Count |Cost function| Constraint...| Step size Procedure Optimization options... l
=) SIS0 Design Task 0 2 0 57.12 =
({7 Design Histors 1 14 0 1.777 8.36 Display options. ..
i Design Opera 2 21 0 1.697 12.1 Hessian m...
L opl 3 28 0 0 217
Optimization
progress
~
Constructing optimization problem... =
Optimization started 10-Nov-2008 14:01:11
Optimization finished 10-Nov-2008 14:01:21
Successful termination. Found a feasible or optimal solution within the specified P
tolerances. X 4 Optimization
status
=
M

[ EHE

Redo

6 Evaluate the controller design.

a Examine the system's response in the response plot, for example the Bode plot,
to see if it meets the requirements. The system's response must lie in the white
region in order to meet the design requirement.
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) SISO Design for SISO Design Task oy ] 54
File Edit Wiew Designs Analysis Tools Window Help ~
« o PR
X o & &+ |®aom e
Open-Loop Bode Editor for Cpen Loogp 1 (L1
40 T T T T T T
20 - =
0 -
o
=0 E
§ Reguirement:
E a0 Phd = BD_
[
=
=) J
G Int
80| Freq: Inf B
Stable loop
00 Ll MR | Ll PR
-0 T T T T
=
Ui}
=
o -135F u
w
[+
—
o
P 861 deg
Freg 2.79 radizec
Bl e e — g e e e b e g el e o T
107 107 107 10" 10" 10° 10° 10"
Freqguency (radfsec)
Undaoing Optitize compensators.

b Examine the controller parameter values in the Compensator tab.
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Optimized controller
parameter values

[=] Control and Estimation Tools Manager ! 1ol x|
File Edit Tools Help
SgD|cd|2 &
[\ Workspace Overview C | Design requi | Optimization |
=l Project - sldo_modal2 Select elements to optimiz
(-1 d Operating Points — — — - -
= Simulink Compensator De |~ Optimize Compensator elements I Value ]lnlbalguess] Minimum I Maximum ITypl(aIv...
-1 SI50 Design Task [~ sldo_model2/Controller
Design History v P 6.7627 1 -Inf Inf 1
Design Operating v 1 3.4445 0.1 -Inf Inf 1
#°) Response Optimi v D 11.106 0.1 -Inf Inf 1
r N 100 100 -Inf Inf 1
Right click name to its
it imae Use Value as Initial Guess |
‘l I _’I Help
-
=
Z|

7  Write the controller parameter values into the Simulink model. To do so, click
Update Simulink Block Parameters in the SISO Design Task node.

See Also: “Design Optimization-Based PID Controller for Linearized Simulink Model
(GUI)”.
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Design Optimization-Based PID Controller for Linearized Simulink
Model (GUI)

In this section...
“About This Tutorial” on page 4-15
“Configuring a Project for Optimization-Based Control Design” on page 4-16

“Designing an Initial PID Controller to Meet Bode Magnitude and Phase Margins
Requirements” on page 4-22

“Refining the Controller Design to Meet Controller Output Bounds” on page 4-42

“Saving the Project” on page 4-57

About This Tutorial

* “Objectives” on page 4-15
+ “About the Model” on page 4-15

* “Design Requirements” on page 4-16

Objectives

In this tutorial, you learn to use optimization methods to design a PID controller to meet
frequency-domain design requirements on a system's response.

You accomplish the following tasks using the GUI:

* Specify frequency-domain Bode magnitude and phase margin requirements.
* Design an initial controller to meet the frequency-domain requirements.

* Refine the initial controller design to limit the controller's output signal.

About the Model

In this tutorial, you use the Simulink model named sldo_model 2, as shown in the next
figure.
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4-16

EL’ PID ! »{In1 ot |

Unit Step

Confroller Plant

The model contains a Control ler block, which is a PID Controller. This block controls
the output of the Plant subsystem.

Using the Simulink Control Design software has linearized the Simulink model at

the operating point specified in the model. The sldo_model2._mat file contains a
preconfigured SISO Design Tool session saved after linearizing the model. To learn more
about linearizing Simulink models for control design, see “Control Design”.

Double-click the Plant subsystem to open it. The plant is modeled as a second-order
system with delay. It contains Transfer Function and Transport Delay blocks, as shown
in the next figure.

m s24+2 Wl zetas+wl "2 ot

Transport Delay

Transfer Fon

To learn more about the blocks, see “Transfer Fen” and “Transport Delay” block reference
pages.

Design Requirements

The compensator you design in this tutorial must meet the following design
requirements:

*  Bode lower magnitude bound of 0 in the frequency range le-3 to 1 rad/sec
* Phase margin greater than 60 degrees
+ Controller output bounds in the range [-250 550]

Configuring a Project for Optimization-Based Control Design

To design a linear controller for a Simulink model, you must first configure a Control and
Estimation Tools Manager project.
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Open a SISO Design Tool session for the linearized Simulink model by typing the
following command at the MATLAB prompt:

sisotool ("sldo_model2_.mat*®)

Note: sldo_model2._mat file contains a preconfigured SISO Design Tool session.
This session was saved after Simulink Control Design software linearized the
sldo_model2 Simulink model.

This command opens the following windows:

Simulink model

4
b—’ PID ! »in1 o

Unit Step

Confrollar Flant

To learn more about the model, see “About the Model” on page 4-15.

*  Control and Estimation Tools Manager GUI, which contains a SISO Design
Task node under the Simulink Compensator Design Task node.

4-17



4 Optimization-Based Linear Control Design

4-18

E! Control and Estimation Tools Manager o ] 4|
Fil=  Help
g0 (&
Workspace rProject Settings
IS8~ FProject - sldo_model2
!d i ”‘IH - Title: |Pr0]'ect- sldo_modelz
) Cperating Points
-] simulink Cump.ensatur De e I
B SIS0 Design Task
Created by: I
Date modified: 10-Nov-2008
Simulink model:  sldo_model2
Description: ;I
=]
dl | ©
2
[~
Project node. 4

+ Closed-loop step response of the system in the top plot
*  Output of the Control ler block in the bottom plot

LTI Viewer for SISO Design Task window, which contains the following plots:




Design Optimization-Based PID Controller for Linearized Simulink Model (GUI)

) LTI Viewer for SISO Design Task o ] 4|
File Edit Window Help
0 &R K |E
Step Rezponze
From: Unit Step To: Out{1)
T T T
o
=
= J
g
1 1 1 1
60 an 100 120 140
Time (=zec)
Step Response
From: Unit Step To: Qut(1)
1 T T T T
@ 10 4
=
2
o
£ st 1
gL~~~ | 1 | 1
1] 0.05 0.1 .15 0z 0.25
Time (zec)
LTI iewer [ Real-Time Update

+ A blank SISO Design for SISO Design Task window
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SIS0 Design for SISO Design Task

2 In the Control and Estimation Tools Manager GUI, select the Automated Tuning
tab in the SISO Design Task node.
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E!(ontroland Estimation Tools Manager i =] 5]
File Edit Tools Help

(= il =™ A
*_ﬁ Workspace archltecture| Compensatar Edltorl Graphical Tunmgl Analysis Plots  Automated Tuning I
=T Project - sldo_modelz

% Operating Paints Design method: IOptimizatinn Based Tuning ;I
imullnk Compenzator Dy ;- Optimization Based Tuning

‘ou can use opkimization-based kuning to create an initial compensatar design or to refine the current compensatar
design:

Graphically specify design requirements For your system by positioning bounds on design ar analysis plots such as
Bode, Michals, or Step Response. Then, use optimization-based methods to automatically tune compensator elements

to satisFy the design requirements. Compensatar elements that are tunable via optimization-based kuning include
gains, poles, and zeros.

Requires the Simulink Design Optimization product,

Optimize Compensataol

Update Simulink Black Parameters | [~ Automatically update block parameters Help |

. _bl Staore Design

5150 Design Task Node.

s LI

Click Optimize Compensators.

This action creates a new Response Optimization node.
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4-22

E!(ontroland Estimation Tools Manager i ] 5
File Edit Tools Help
i il = ™ (A
ﬂ_:\ Workspace Overview I Compensatorsl Design requirements | Opt\mlzatlonl
=1- W Project - sldo_modelz ST
&L Operating Points
=-21) Simulink Compensator Design
A 5
(118 SIS0 Design Task | I
Ex-L[T Design Histary 1 I
- |z Design Operating Pair Step 1 I Step 2 I Step 3
P ¥ < ponse Optimizatio : :
| Set optimization I
: options :
1 I
Select 1 I
compensators to 1 I
optimize 1 I
I ! 1
| ]
1 I
Optimize T - View results
1 I
| ]
1 I
Select design 1 1
requirements : :
1 I
| I
1 I
. | _’I Skart Cptimization |
E
[
Response Optimization v

Designing an Initial PID Controller to Meet Bode Magnitude and Phase

Margins Requirements

“Specifying the Controller Parameters” on page 4-22

“Specifying Bode Magnitude and Phase Margin Design Requirements” on page

4-26

“Designing the Controller” on page 4-36

Specifying the Controller Parameters

In this portion of the tutorial, you specify the controller parameters to design.

You must have already configured a project for control design, as described in
“Configuring a Project for Optimization-Based Control Design” on page 4-16.
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To specify the controller parameters to design:

1

In the Control and Estimation Tools Manager GUI, select the Compensators tab in
the Response Optimization node.

E!(ontrol and Estimation Tools Manager i =] |

File Edit Tools Help
= il = ™ A

ﬂ:\ Workspace Qverview Compensators | Design requlrementsl Optlmlzat\onl

E‘G Project - sldo_modelZ | alact compensatar elements to optimi

- Operating Points

=-6] simulink Compens [~ Optimize Compensatar elements I Value I Initial guess | Minimum Maximum Typical valus
Eﬂ SIS0 Design O sldo_model2/Controller
([ Design Hi ml Gain -Inf Inf
g Design Q) ml Real Zero -Inf Inf
a2 | Real Zera -Inf Inf
O Real Pole -Inf Inf

Right dlick on a compensator name ta changs its raprasentation.

Wse Value, as Initial Guess |

i | » Skart Optimization | Help |

s Ll

Response Optimization

The controller parameters appear as poles and zeros in the Compensator elements
column and represent the following:

+  Gain — Overall gain of the controller

Real zeros — Zeros resulting from the differentiator and integrator

Real pole — Pole resulting from the low-pass filter of the differentiator

Tip To view the structure of the Control ler block, right-click the block and select
Mask > Look Under Mask.
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2 For convenience, change the PID controller parameters to Simulink block mask

parameters format. To do so, right-click the sldo_model2/Controller column, and
select Parameterized format.

E!Controland Estimation Tools Manager - ol =l
File Edit Tools Help

d0cd|9 ™

4). Workspace
=Tl Project - sldo_model2

Overview Compensators I Design requirements I Opt\mizationl
~Select compensator elements ko optimize

L Operating Points
-6 simulink Compensator Design I~ Opti... Compensator elements I Value I Initial gu...I Minimum | Maximum | Typical ...
%] 5150 Design Task | sldo_model2/Controller
T b v Pale[Zero Format | 3 3
([ Design Histary 1 Gain -Inf Inf 0.1
Design Operating Poir O Real Zero -Inf Inf
-] Response Optimizatio ] Real Zero -Inf Inf
O Real Pole -Inf Inf

Right click on a cornpensator nama ta change its rapresentation.

Use Value as Initial Guess |

1 | LI Start Optimization | Help |

Response Optimization

NIEAD

This action displays the controller parameters as Simulink block mask parameters
P, I, and D, as shown in the next figure. To learn more about mask parameters, see
“Mask Parameters” in the Simulink documentation.
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=] Control and Estimation Tools Manager =101 x|

Filz= Edit Tools Help
(il =N AN

ﬂ Workspace Overview Compensators | Design requirementsl Optimizat\on'
=i Project - sldo_model2

[+ Operating Points

~Select compensator elements ko optimi;

B8] Simulink Compensator Design Task I~ Optimize Compensator elements | Value | Initial guess I Minimum Maximum ITyp\caI value
=1-#) SIS0 Design Task sldo_model2/Controller
[ Design History F 1 1 Inf Inf

Design Operating Paint

0.1 0.1 -Inf Inf
p ‘J Response Optimization

I
o] 0.1 0.1 -Inf Inf
M 100 100 -Inf Inf

a1 {

Right click on 2 compensator name ta change its representation,

Use Value as Initial Guess |

4 |_,| Start Optimization | Help |

s L Lk

Response Optimization

The Compensators tab displays the following parameter settings:

+ Value — Current controller parameter value
+ Initial Guess — Initial controller parameter value
+  Minimum and Maximum — Controller parameter bounds

+ Typical Value — Scaling factor for the controller parameter

Note: Compensator elements or parameters cannot have uncertainty when used with
frequency-domain based response optimization.

In the Optimize column, select the check boxes for P, 1, and D.
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4-26

=] Control and Estimation Tools Manager =101 x|
Fil= Edit Tools Help

dDEd|9 e

ﬂ)« Workspace Overview Compensators | Design requirementsl Optimizat\on'

- Project - slda_model2 ~Select compensator elements ko optimi
- Operating Points

B8] Simulink Compensator Design Task I~ Optimize Compensator elements | Value | Initial guess I Minimum | Maximum ITyp\caI value
=1-#) SISO Design Task O sldo_model2/Controller
-7 Design History v P [ i I i [ wf | [ 1
Design Operating Point I I 0.1 0.1 -Inf Inf 1

ﬂ Response Optimization

O M 100 100 -Inf Inf 1

Right click on 2 compensator name ta change its representation, "
Use Value as Initial Guess |

| |_,| Start Optimization | Help |

s L Lk

Response Optimization

Specifying Bode Magnitude and Phase Margin Design Requirements

In this portion of the tutorial, you specify the Bode magnitude and phase margin
requirements that the controller must satisfy.

Before you specify the design requirements, you can specify the controller parameters to
design, as described in “Specifying the Controller Parameters” on page 4-22.

To specify the Bode design requirements:

1 In the Response Optimization node of the Control and Estimation Tools Manager
GUI, select the Design requirements tab.
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ﬂ Control and Estimation Tools Manager
Filz= Edit Tools Help

gdDEd|92 e

=10ix]
4:\ Workspace Overview' Compensators Design requirements I Optimization
- Project - slda_model2 ~Select design requirements ko satisFy
[+ Operating Points
= Simulink Compensator Design Task [~ Optimize I Response plat Design requirement
=-#] 5150 Design Task
- iﬁ Design History
Design Operating Point
L ﬂ Response Optimization
Click the 'Add new dasign requirement’ button ar right click on a plot to add a new dasign requirement.
Show Plots | | Add new design requirement... i
a | I_'I Skart Optimization | Help |
Response Optimization
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2 Click Add new design requirement.

This action opens the New Design Requirement dialog box.
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) Mew Design Requirement -10] =]

Design requirement type:

Requirement for response: ICInsed Loop from Unit Step ta Plant LI

—Design requirement parameters

Initial value: I o Final value:
Step time: I 1]

Rise time: I 5z % Rise: B
Settling time: I 10 % Settling: 1 0000
% Overshoot: I 10,0000 % Undershoot:

OK | Cancel | Help |

il

3 Specify the Bode magnitude lower limit requirement:

a In the New Design Requirement dialog box, select Bode magnitude lower
lLimit from the Design requirement type drop-down list.

This action updates the New Design Requirement dialog box, as shown in the
next figure.
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Design requirement type:

Requirement Faor response:

I Loop From Unit Step ko Controller LI

~Design requirement parameters
Segments:
Skart End
Frequency | Magnitude | Frequency | Magnitude Slope Weight
1 0 10 0 0 1
Insert | Delete |
QK | Cancel | Help |

Select Open Loop at outport 1 of Controller from the Requirement

for response drop-down list.

In the Frequency field of the Start column, enter 1e-3.

In the Frequency field of the End column, enter 1.

The New Design Requirement dialog box resembles the following figure.
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) New Design Requirement - 0] x|

Design requirement type: IEh:ude ragnitude lower limik LI

Requirement For response: I ..&n Loop at autpart 1 of Cantraller LI

—Design requirement paramekers

Segments:
Skart: End
Frequency | Magnitude | Frequency | Magnitude Slope Weight
1.0000=-03 ol 0 U] 1

Insert | Delete |

oK | Cancel | Help |

e Click OK to close the New Design Requirement dialog box.

The Bode lower magnitude limit is added to the Design requirements tab, as
shown in the next figure.
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File Edit Tools Help
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Show Plots | | Add new design requirement...
Stark Cptimization |

Help |
Unda

s LI

The SISO Design for SISO Design task window also updates to show the Bode plot
with the design requirement displayed as the black line segment.
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Right-click on the plots for more design options.

4 Add the phase margin requirement:

a In the SISO Design window, right-click the white area on the top plot, and select
Design requirement > New.
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Right-click on the plots for more design options.

This action opens the New Design Requirement dialog box, as shown in the next

figure.
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) New Design Requirement =101 x|
Design reguiremesnt t'y'pe:ILlpper gain limit ;I
~Design requirement parameters
Segments:
Skart End
Frequency | Magnitude | Frequency | Magnitude Slope Weight
1 0 10 0 0 1
Inserk | Delete |
Cancel | Help |

b Inthe New Design Requirement dialog box, select Gain & phase margins
from the Design requirement type drop-down list.

The New Design Requirement dialog box updates to display the Gain Margin >
and Phase Margin > options, as shown in the next figure.

) New Design Requirement o ] |

Design requirement type: | iR ik

Design requirement paramekters

[T Gain margin = I 20

[~ Phaze margin = I 30

0K | Cancel | Helgp |

¢ Select the Phase margin > check box, and enter 60 in the adjacent field. Then,
click OK to close the dialog box.
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| Mew Design Requirement 10| x|

Design reguiremesnt t'y'pe:l...in & Phase margins ;I
Design requirement parameters

[ Gain margin = I

20

¥ Phase margin = IEIZI

OK | Cancel | Help |

The Design requirements tab in the Control and Estimation Tools Manager

GUI updates. It now displays the phase margin requirement, as shown in the
next figure.

E Control and Estimation Tools Manager
File Edit Tools Help

ol x|
gl Ed|2 &
ﬂ Warkspace Overview | Compensators Design requirements I Optim\zationl
E‘“ Project - slda_madel2 ~Select design requirements ko satisfy

[+ Operating Points

E}% Simulink Compensator De [~ Optimize Response plot I Design requirement

E:] SISO Design Task | Open Loop at outport 1 of Controller
Design Histary ¥ Open-Loop Bode Editor For Open Laop 1 (L1) | Lawet gain limit From 0.001 to 1 rad]sec
Design Operating Vv Open-Loop Bode Editor For Open Loop 1 (L1) | Requirement: PM = &0
ﬂ Response Cpkimi

Click the 'Add new design rzquirernent’ button or right click on a plat to add a new design requirement.,

Shaow Flots | ‘ Add new design requirement... |

Start Optimization | Help |

LRI
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The SISO Design window also updates to display the phase margin requirement.
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Right-click on the plots for more design options.

Designing the Controller

In this portion of the tutorial, you design the controller to meet the Bode magnitude and
phase requirements.

You must have already specified the controller parameters to design, as described in
“Specifying the Controller Parameters” on page 4-22, and the design requirements,

as described in “Specifying Bode Magnitude and Phase Margin Design Requirements” on
page 4-26.

To design the controller:
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In the Optimization tab, click Start Optimization.

7] Control and Estimation Tools Manager
File Edit Tools Help

(=]
gD S d|9
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=B Praject - slda_model2  Optimization pragr
[ Operating Paints
-] Simulink Compensator Design Task Iteration | Eval-Count | Cost function I Constraint ... I Step size Procedure | Optimization options. .. |
=¥ 5150 Design Task -
B [} Design Histary Displsy options...
Design Operating Point
L) S imization
[ |
=
|
‘I Ij Skark Optimization '\J Help I
L
F
=
Response Optimization v

The Optimization tab updates as shown in the next figure.
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File Edit Tools Help
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+ At every optimization iteration, the default optimization method Gradient
descent reduces the distance between the current response and the

magnitude requirement line segment by modifying the controller parameters.
Simultaneously, the software also computes the phase margin and reduces the

distance between the current response and the phase margin. To learn more
about the optimization method, see “Selecting Optimization Methods”.

+ After the optimization completes, the Optimization tab displays the
optimization iterations and status, as shown in the next figure.
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E! Control and Estimation Tools Manager ] 1

File Edit Tools Help

il = ™

‘_ﬁ Workspace Overview | Compensators | Design requirements  ©ptimization I
=Tl Project - sldo_model2 ~Optimization progr
[+ | Operating Points
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Design Opera 2 21 0 1.697 12,1 Hessian m...
.. #) Resporse Opl 3 28 0 0 21.7
-]
Constructing optimization problem... d

Dptimization statted 10-Now-2008 14:01:11

Qptimization finished 10-Mow-2008 14:01:21

Successful termination. Found a feasible ar optimal solution within the specified
talerances.

NG

Redo

The message Successful termination indicates that the optimization method
found a solution that meets the design requirements. For more information

about the outputs displayed in the Optimization progress table, see “Iterative
Display” in the Optimization Toolbox documentation.

2 Examine the controller parameters and the system's response:

a View the optimized parameter values in the Value field of the Compensator
tab.
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+ The SISO Design window

b Examine the system's response on the following plots:
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* The top plot shows that the magnitude of the system, displayed as the
blue curve, lies outside the yellow region. This plot indicates that the
system has met the Bode magnitude requirement.

*  The bottom plot displays the phase margin (P.M.) value of 86.1 degrees.
This indicates that the system has met the phase margin design
requirement of >60 degrees.

* The LTI Viewer
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* The top plot shows that the closed-loop response of the system is stable.
The system with the designed controller thus meets both the magnitude
and phase margin requirements.

* The bottom plot in the LTI Viewer shows that the peak value of the
controller's output is 1000, which is very large and can cause damage
to the plant. To limit the controller output, you apply lower and upper
bounds on the signal, as described in “Refining the Controller Design to
Meet Controller Output Bounds” on page 4-42.

Refining the Controller Design to Meet Controller Output Bounds

In this portion of the tutorial, you refine the controller to satisfy bounds on the
controller's output.
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You must have already designed an initial controller, as described in “Designing an
Initial PID Controller to Meet Bode Magnitude and Phase Margins Requirements” on

page 4-22.

To tune the compensator parameters to meet the bounds on the controller's signal:

1

Add the upper-bound on the controller's output:

a Inthe LTI Viewer, right-click the white area on the bottom plot, and select

Design requirement > New.
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File Edit Window Help
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E Characteristics 4
0 Grid
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_500 I I I I
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Propetties...
LTI vigwer ¥ Real-Time Update

Design Requirements k
Edit...

This action opens the New Design Requirement dialog box.
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) New Design Requirement

Design reguirement type:lStep responses bounds
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~Design requirement parameters
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Rise time: |—5 % Rize: I—gn
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b Inthe New Design Requirement dialog box, select Upper time response
bound from the Design requirement type drop-down list.

) New Design Requirement =101 x|
BT T VT Ty AT L pper time response bound
~Design requiremenkt parameters
Segments:
Skart End
Time Amplitude Time Amplitude Slope Weight
0 1 10 1 1
Inserk | Delete |
OK | Cancel | Help |

¢ In the Time field of the End column, enter Inf.
d Inthe Amplitude field of the Start column, enter 550.
e Inthe Amplitude field of the End column, enter 550.
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The New Design Requirements dialog box resembles the following figure.

) New Design Requirement o o] oA |

Design reguirement type:IUpper time response bound LI

~Design requirement parameters

Segments:

Start End
Time Amplitude Time Amplitude Slope ‘Weight
a 550 Inf |550] 0 1

Inserk | Delete |

OK | Cancel | Help |

Click OK to close the dialog box.
The Design requirements tab in the Control and Estimation Tools Manager

GUI updates. It now displays the upper-bound requirement, as shown in the
next figure.
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The LTI Viewer also updates to show the design requirement, as shown in the
next figure.
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Add the lower-bound on the controller's output:

a Right-click the white area in the bottom plot in the LTI Viewer, and select

Design requirement > New.

This action opens the New Design Requirement dialog box.

b Select Lower time response bound from the Design requirement type
drop-down list.

The New Design Requirement dialog box updates to show the lower bound, as
shown in the next figure.
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) New Design Requirement =101 x|
BT T DT Ty AT A | ower time response bound
—Design requirement parameters
Segments:
Skart End
Time Amplitude Time Amplitude Slope Weight
0 1 10 1 1
Inserk | Delete |
OK | Cancel | Help |

¢ In the Time field of the End column, enter Inf.
d Inthe Amplitude field of the Start column, enter -250.
e Inthe Amplitude field of the End column, enter -250.

The New Design Requirement dialog box resembles the next figure. Click OK to
close the dialog box.
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J New Design Requirement =101 x|
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~Design requirement parameters
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The Design requirements tab in the Control and Estimation Tools Manager
GUI updates. It now displays the lower-limit requirement, as shown in the next

figure.
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The LTI Viewer also updates to show the lower-bound on the controller's output,
as shown in the next figure.
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3 Optimize the parameters to meet the design requirements on the controller output:

a

In the Compensators tab, select the rows containing P, 1, and D, and click Use

Value as Initial Guess.
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When you run the optimization again, the optimization method uses the updated
parameter values as the starting point for refining the values.

Clicking Use Value as Initial Guess updates the values in the Initial Guess
column, as shown in the next figure.
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In the Optimization tab, click Start Optimization.

+ At every optimization iteration, the optimization method reduces the
distance between the current response and the upper and lower bounds on

the signal.

+ After the optimization completes, the Optimization tab resembles the next

figure.
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4 Examine the parameter values refined controller and the system's response:

Examine the following response plots:

The LTI viewer



Design Optimization-Based PID Controller for Linearized Simulink Model (GUI)

) LTI Viewer for SIS0 Design Task =] 3]
File Edit Window Help
D&% &
Step Response
From: Unit Stegr Too Cut(1)
151 ' ' ' =
B T T T
=
2
=3
g ost -
0 L L
a 1 2 k| 4 3 -] 7 g &l 10
Time (sec)
Step Response
From: Unit Step Too Cut(1)
1000
o 500 =
=
e
=
5 i R
-500
a 003 01 013 0.2 023
Time (gec)
= I¥ Real-Time Update

The bottom plot shows that the controller output lies between 550 and -250,
and thus meets the design requirement on the controller's output.

Note: You must also check that the closed-loop response, shown in the top
plot, remains stable after refining the controller design.

*  The SISO Design window
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Uncoing Optimize compensators.

The plots show that after refining the design, the system continues to
meet the magnitude and phase margin requirements specified in “Design
Requirements” on page 4-16.
b View the optimized controller parameter values in the Value field in the
Compensators tab.
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Design Optimization-Based PID Controller for Linearized Simulink Model (GUI)

E Control and Estimation Tools Manager i =] 5]

Fil= Edit Tools Help

o il = 1™

ﬂ_l Warkspace Overview Compensators | Design requwrementsl Optlm\zatlonl
E‘“ Project - sldo_modelz ~Select compensator elements to optimi
[+ g Operating Points
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Right click on a compensator name to change its representation,

Use Value as Initial GUess |

Help

s 13 x|

5 Select the SISO Design Task node, and click Update Simulink Block
Parameters.

This action writes the optimized controller parameter values to the Controller
block in the Simulink model.

Saving the Project

To save a project with the optimized controller parameters:

1 In Control and Estimation Tools Manager GUI, select File > Save.

This action opens the Save Projects dialog box.
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4 Optimization-Based Linear Control Design

=

Projects:

=]

OK Cancel | Help |

2 Inthe Save Projects dialog box, select Project - sldo_model2, and click OK to open
the Save Projects window .

3 In the Save Projects window, enter sldo_model2_optimized.mat in the File
name field, and click Save.

The action saves the project as a MAT-file.

Tip You can reload this project by typing sisotool (*sldo_model2_optimized®)
at the MATLAB prompt.
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